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About This Guide

This section provides supporting information for the Oracle Data Foundation Cloud Services for
Banking (DFCS).

Audience

This document contains release information of Oracle Data Foundation Cloud Services for
Banking (DFCS).

Documentation Accessibility

For information about Oracle's commitment to accessibility, visit the Oracle Accessibility
Program website at http://www.oracle.com/pls/topic/lookup?ctx=acc&id=docacc.

Access to Oracle Support

Oracle customers that have purchased support have access to electronic support through My
Oracle Support. For information, visit http://www.oracle.com/pls/topic/lookup?ctx=acc&id=info
or visit http://www.oracle.com/pls/topic/lookup?ctx=acc&id=trs if you are hearing impaired.

Related Resources

e Oracle Financial Services Data Foundation Cloud Service for Banking

Conventions

The following text conventions are used in this document.

Convention Meaning

boldface Boldface type indicates graphical user interface elements associated with an
action, or terms defined in text or the glossary.

italic Italic type indicates book titles, emphasis, or placeholder variables for which
you supply particular values.

monospace Monospace type indicates commands within a paragraph, URLs, code in
examples, text that appears on the screen, or text that you enter.
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Introduction to Data Foundation Cloud Service

ORACLE

The Oracle Financial Services Data Foundation Cloud Service (DFCS) for Banking offers a
consistent, efficient, and well-governed data management solution tailored to meet both
internal and regulatory data requirements for banks. It includes a comprehensive data catalog
designed to support key analytical use cases across finance, risk, and compliance domains.
This solution is powered by a feature-rich platform that enables data ingestion, data quality and
reconciliation, hosts high-quality historical data, and facilitates the distribution of validated data
through extraction routines and data visualization tools, such as reports.

Figure 2-1 Data Foundation
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Oracle Data Foundation Cloud Service (DFCS) is a cloud-native data management and
processing platform that offers a single source of truth by using a unified and integrated results
area. The platform stages the data directly from the source systems, processes it, and delivers
results for downstream consumption.

Below are the salient features of the DFCS:

- Data Foundation prioritizes consistency in definition of data (and its governance) of a
financial institution by using an industry-leading ontology of business terms to model the
data.

- Data Foundation ensures transparency in data management processes by enforcing
Change Management at its core, leading to safer adaptability (extension) of its
comprehensive pre-built data model (and data catalog).

- Data Foundation provides an extensive Results Area that acts as the metaphorical
single-source-of-truth for all data needs of an organization across key functions, such as,
risk, finance, and compliance.

- Data Foundation also standardizes distribution of data to downstream applications and
use cases by providing certifiable interfaces for consumption.
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Chapter 2
Organization of the User Guide

2.1 Organization of the User Guide

This user guide is divided into nine chapters. Chapters 2 through 7 focus on the core modules
of the Data Foundation Platform.

ORACLE

1.

Getting Started: This chapter outlines the process for ordering and configuring the Data
Foundation Cloud Service.

Data Catalog: This chapter details the structure and organization of the Data Catalog,
which outlines the data model for the Data Foundation.

Data Controls: This chapter covers the two types of data controls supported by the
service: Data Quality (DQ) and Reconciliation. It describes the structure of prepackaged
DQ rules and provides guidance on configuring and using these rules, along with the new
reconciliation rules.

Data Integration: This chapter details the data integration features that support the
sourcing of data into the staging area and the extraction of data from the Data Foundation
for downstream consumption.

Data Operations: This chapter details various DFCS tasks that can be combined into a
sequence of data movement activities, including sourcing, curation, and consumption.

Data Visualization: This chapter is divided into two main sections:

- Data Browser: As DFCS is a SaasS service, users require a cloud-based data browser
to explore data. This section explains how to browse both source data and results
data.

e Pre-Built Reports and KPIs: DFCS is pre-configured with pre-built reports and KPIs.
This section provides guidance on using these examples for reference and
customization.

Change Management: All changes in DFSC are managed through a comprehensive
issue-mechanism. This chapter describes how to capture data events as issues and assign
appropriate actions for resolution to the respective action owners.

Key Terms and Concepts: This chapter defines the key terms and concepts used
throughout the User Guide.

Support: This chapter describes how to contact Oracle for support and clarification
requests.

2-2



Getting Started

The Oracle Financial Services Data Foundation Cloud Service (DFCS) for Banking provides a
consistent, efficient, and well-governed data management platform for internal as well as
regulatory/jurisdictional data needs of a bank. It comes with prebuilt data integration pipelines
and a comprehensive data catalog for well-known use cases of a bank.

3.1 Why DFCS?

Consider a bank with a diverse portfolio of products. They aim to accomplish the following two
primary data management objectives.

e Maintain a consistent view of data to meet regulatory obligations and support internal
performance measurement reporting.

e Reduce data sourcing costs by retrieving data once from a book-of-record system and
utilizing it across multiple downstream applications.

Suppose the bank encounters challenges in achieving these objectives:

e The data nomenclature used by regulatory agencies and internal use cases does not align
well with the terminology used in book-of-record systems.

e Each consuming application is developed independently, making it easier to source data
multiple times rather than achieving alignment across all consuming applications.

To address these challenges and achieve their data management objectives, the bank decides
to implement DFCS.

» DFCS offers a unified view of data sourced from book-of-record systems for all commonly
known consumption use cases in a bank. With DFCS, the bank only needs to source data
once, regardless of the number of downstream use cases currently in scope.

« A standardized set of quality-checked and reconciled datasets feeds into downstream
applications, ensuring consistent reporting for both regulatory and internal use cases.

3.2 Product Setup

To get started, you must activate the Data Foundation Cloud Service (DFCS). Refer to Oracle®
Financial Services Data Foundation Cloud Service for Banking Getting Started Guide

3.3 DFCS User Interface

ORACLE

The Data Foundation Cloud Service (DFCS) application provides a tailored user interface
based on the user's role. The landing page and available menu options are dynamically
adjusted according to the user's assigned group.

1. Business Analyst User — Focused on data exploration and analysis.

2. Data Governance Analyst User — Provides tools for data quality, compliance, and
governance.
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Chapter 3
DFCS User Interface

3. Administration User — Manages system configurations, user access, and administrative
tasks.

Each user group sees a customized dashboard and navigation menu, ensuring a role-specific
experience within the application.

3.3.1 User Group Mapping for Landing Page
The landing page configuration is determined by the user’s assigned group:

Table 3-1 User Group Mapping

User Group User Type

e DFBSYSADMN Administration user

«  DFBAPPADMIN

e DFBQLTCNTRL Data Governance / Data Controls User
e DFBRECONADMIN

DFBCATLGOWN Business Analyst user

3.3.2 User Group and User Role Mapping

The following table provides the User Group and User Role Mapping:

Table 3-2 User Group and User Role Mapping

|
User Group Code Activities

Identity Administrator *  View Reports
*  View Object Storage
e View OAuth Credentials
e Perform Identity and Access Management Operations

Identity Console Administrator e Create Users
*  Map Users to the Instance
Data Foundation Administrator e User Group with Setup Roles

¢ View all content
. DFCS Service Administration Activities
¢ Access PMF Dashboard

DFCS-BIAdministrator Administer Data Visualization Content
DFCS-BIContentAuthor Author Data Visualization Content
DFCS-BIConsumer Access Data Visualization Content
Data Foundation Business User ¢ Use the DFCS Service

. Register, modify, or delete Entity-maps, Rules, Look-
up, Adjustments, Corrections and so on

. Register, modify, or delete EDD, Connector and so on

e Register, modify or delete SLA, Source Registration,
Event Grouping, Segment Code - Dimension
Mapping and so on

e Configure and Manage Pipelines

*  Execute Pipelines

Data Foundation System Administrator e Perform System Administration activities
For Example: Configuring Instance name

Data Foundation Approver Approver across all service features
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Chapter 3
DFCS User Interface

Table 3-2 (Cont.) User Group and User Role Mapping
]

User Group Code Activities

Data Foundation Data Access View data using API

DFCS-DVConsumer Access Data Visualization Content for Catalog
DFCS-DVContentAuthor Author Data Visualization Content for Catalog
Foundation Operations User Group e Configure and Manage Pipelines
(DFCSOPRSGRP) »  Execute Pipelines

¢ Access PMF Dashboard
e Perform File Operations
*  View Issues and Actions

3.3.3 DFCS Business Analyst User Interface

The Business Analyst User interface in DFCS is designed to support data exploration and
analysis. It provides tools and functionalities that enable users to access, analyze, and
visualize data efficiently.

3.3.3.1 Data Catalog - Line of Business (LOB)

ORACLE

Upon logging into the DFCS application, a Business Analyst User is presented with a
streamlined interface tailored for efficient data exploration and issue tracking.

Landing Page Components
« Data Catalog View:

— Access Line of Business (LOB) and Subject Area views.

— Ability to view Entities and Ingress Connectors for data exploration.
» Data Browsing & Issue Logging:

— Browse Data with a dropdown option to refine searches in the Subject and Results
area.

— Log Issue directly from the home page for quick issue reporting.
e Task List & Issue Management:
— Displays the top 5 items from Issues & Actions, highlighting overdue tasks.
— Option to Review Issues directly from the home page without navigating to the inbox.

— View Inbox option for a full list of tasks and communications.

Table 3-3 Data Catalog — Line of Business (LOB): Landing Page Components
|

Menu Option Description

Source / Results Land on the OAS Home page

Log Issue Open Issues and Actions module

Review Open Issues and Actions module

View Issue Open Issues and Actions module

No. of Ingress Connectors Open Ingress connectors, no default filtration

available for now

Number of Entities Open Entities, no default filtration available for now
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DFCS User Interface

# Note:

The Task List displays only the five most recently updated items from Issues &
Actions, based on the latest available updates.

The View Inbox button below the task list, the Review button for each task item, and
the Log Issue button all redirect to the same page—Issues & Actions—functioning
similarly to an inbox. They do not navigate to any specific issue within Issues &
Actions.

3.3.4 DFCS Data Governance Analyst User Interface

ORACLE

Upon logging into the DFCS application, a Data Governance |/ Data Control User is
presented with a dashboard displaying key data quality and reconciliation metrics through
sample graphs.

Landing Page Components:
< Data Quality Monitor (DQ Monitor):
— Displays two graphs:
1. Data Error Ratio
2. Number of Records Failed vs. Scanned

— Clicking on the DQ Monitor graph redirects the user to the Data Visualization Report
for DQ Monitor.

— A "Refresh Data" button at the top right corner allows users to update the displayed
data.

* Reconciliation Difference:
— Displays two graphs:
1. Source and Target Balances
2. Negative and Positive Absolute Differences

— Clicking on the Reconciliation Difference graph redirects the user to the Data
Visualization Report for Reconciliation Difference.

— A Refresh Data button at the top right corner allows users to update the displayed
data.
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Figure 3-1 DFCS Data Governance Analyst User Interface
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3.3.5 DFCS Administrator User Interface

Upon logging into the DFCS application, an Administrator User is presented with a Foldout
Menu and a Task List for efficient system management and oversight.

ORACLE

Landing Page Components:

Foldout Menu:

— Provides access to key administrative functions, including:

1. Data Catalog

2. Data Integration
3. Data Controls
4

Data Visualization

Table 3-4 Landing Page Components

|
Sub menu options

Foldout Menu Item

Data Catalog

Business Terms
Entities
*  Extend Data Catalog

Data Integration

Data Source Templates
Data Pipelines
Data Extraction
Connectors
*  Add Data Source Templates
*  Add Data Pipelines
*  Add Data Extraction
*  Add Connectors

Data Controls

Data Quality Check
Data Quality Group
Data Quality Exceptions

Reconciliation Rules
*  Add Reconciliation Rule
*  Extend Data Quality
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Table 3-4 (Cont.) Landing Page Components

|
Foldout Menu Item Sub menu options

Data Visualizations —  Source Data Visualization
— Results Data Visualization
— Data Quality Dashboard
—  GL Reconciliation Dashboard

— Add New Visualization
*  View Sample Reports

# Note:

The number displayed beneath the items in the Foldout menu denotes the
cumulative count of items available under that category.

3.4 Setting Up Your Service

This section provides the details on setting up Data Foundation Cloud Service (DFCS).

e Pre-deployment process for the Domain

* Post-deployment process for the Domain

3.4.1 Pre-deployment process for the Domain

The pre-deployment process requires selecting business domains, which determine deployed
data and metadata. Domains can be added later but cannot be removed once deployed. Extra
domains do not impact service usage.

«  Domain

3.4.1.1 Domain

Domains represent business segments that you operate. The list of domains available with
your service will be listed for you to choose from. Your choice will determine data and metadata
artefacts that are deployed by the service for your use. You may choose one or more domains
and subsequently revise your choice with additional domains, as needed. You will not,
however, be allowed to drop domains once selected and deployed. Please note that additional
domains, even when chosen in error, will not adversely affect your usage of the service.

3.4.1.1.1 Select your Domain

This section helps you to select the business domain that aligns with your data deployment.
This will tailor the service to instantiate the right data structure for banking-specific needs.

1. Inthe Choose Domain page, select Banking to deploy.
2. Click Continue.

A confirmation message is displayed.

ORACLE .
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# Note:

» If you click Continue without selecting a domain, a warning message Please
select at least one domain. appears.

» Once you select a domain, the Continue button is enabled.

« By clicking Continue, the deployment process is initiated for the selected
domain.

* The system displays the deployment status, indicating progress and
completion.

3.4.1.1.2 Deploying the Domain

ORACLE

1.

On the Deploy Domain page, the deployment steps, and the status of the deployment is
displayed.
The following is the list of steps initiated in the deployment process.

Deploy Catalog: Deploys a physical instance of data structures based on the selected
Domains.

Refresh Data Interface: Generates and deploys a logical abstraction layer to support
Data Services, following the specifications in the Catalog.

Generate Data Quality Checks: Creates and deploys Data Quality assessment
routines as per the specifications in the Data Catalog.

Deploy Dimension Rules: Deploys Dimensions required by the service, including
Slowly Changing Dimensions (SCDs).

Reporting Object Registration: Registers reporting objects, enabling them to be
accessed and utilized within the reporting framework.

Generate Data Connections: Deploys Data Services necessary for facilitating data
movement within the deployed data structures.

Applying Redaction Policy: Implements data protection by applying redaction rules
to sensitive portions of the Catalog, including Personally Identifiable Information (Pll).

Generate Pipelines: Creates and deploys process definitions in the service's Process
Management Framework to execute required functional tasks.

Deploy Application Data Service: Deploys the data service layer required for
application-level interactions with the underlying data structures.

The following is the list of statuses displayed in the deployment process.

Deployment Status Indicators: Each step is marked with a success, failure, or yet to
start status.

Deployment Progress: The deployment status will change to Ongoing.

Verify Deployment Status: Ensure that all deployment statuses are marked as
Completed.

Click Start Deployment to initiate the process.

Once the deployment is Successful, you will be automatically redirected to the login page.
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¢ Note:
» If you are still logged in when the deployment is completed, you will be
redirected directly to the homepage.

» If you log out after triggering the deployment and log back in later, you will be
taken to the homepage.

« If the deployment is still in progress, you will be redirected to the deployment
page displaying the progress.

3.4.2 Post-deployment process for the Domain

After the deployment process is complete, additional steps are required to ensure the domain-
specific configurations are fully functional and optimized.

1. After completing the pre-deployment steps, the admin must configure the following:
a. Legal Entity
b. Fiscal Period
c. Configure Parameters

2. To configure the above steps, navigate to the DFCS URL, and then click the User Menu >
Administration.
The system displays all the required configurations.

3.4.2.1 Legal Entity

The Legal Entity setup is used to define the reporting currency and specify the fiscal period for
posting entries. You can configure one or more Legal Entities for which the service maintains
the Management Ledger and performs related financial tasks.For each Legal Entity, a
Management Ledger is maintained to generate financial reports as part of the reporting
process. The service also supports a hierarchical structure of Legal Entities, enabling the
capture and organization of financial data accordingly.

* Legal Entity Settings

# Note:

Maximum levels supported for Legal Entity hierarchy in Balance reconciliation is
5.

3.4.2.1.1 Legal Entity Settings

ORACLE

The Legal Entity Settings allow you to define the reporting currency used for financial
transactions and reporting.

To set up the Reporting Currency, follow these steps:

1. To access Legal Entity Settings, go to the Home page, click Administration, and then
select Legal Entity.

The Legal Entity Settings page is displayed.
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2. On the Legal Entity page, all available Legal Entities are listed on the left-hand side. To
configure the Reporting Currency and Fiscal Year for a specific Legal Entity, follow these
steps:

a. Select the required Legal Entity from the list (if available).

b. Set the fiscal period to open for posting entries by disabling or closed for posting
entries by enabling the Locked? option. An open posting period is when the selected
posting period is set to open and the other posting periods stay closed.

c. Set the Reporting Currency to the required standard. This Reporting Currency is
used during the Execution Process in Process Orchestration.

3. Click Save to save the Legal Entity settings.

3.4.2.2 Fiscal Period

The Fiscal Period Setup allows you to define the financial reporting periods for a specific
Legal Entity. It ensures all transactions are recorded within the correct accounting periods,
supporting accurate financial reporting and compliance with fiscal regulations.

e Set Up Fiscal Periods

e Compile Fiscal Periods

3.4.2.2.1 Set Up Fiscal Periods

ORACLE

Using this setup, you can:

* Add a new Fiscal Period to establish reporting timelines.

- Edit an existing Fiscal Period to update details such as start and end dates.
Open or close posting periods to control financial entries.

To add or edit a Fiscal Period, perform the following steps:

During deployment, an Administrator can set up Fiscal Periods using the procedure outlined
below. After deployment, Fiscal Periods can be managed from the Fiscal Period Settings
page. To access this page:

1. To navigate to the Fiscal Period Settings screen, on the Home page, click User Menu >
Administration > Fiscal Period.
The Fiscal Period Settings page is displayed.

Adding Fiscal Period

1. Click the Setup tab, the four built-in Fiscal Year Quarters are displayed: Quarter 1,
Quarter 2, Quarter 3, and Quarter 4.

2. Select the required quarter for a specific Legal Entity before proceeding.
3. Click Add Fiscal Period to add a new row in the Fiscal Periods list.

4. Double-click the Fiscal Period Name to edit and update it.

# Note:

The Fiscal Period Name and Quarter Name must contain 50 or lesser characters.

5. Double-click the Start Month field and select the required month (default: January).

6. Double-click the Start Day field and choose the appropriate start day.
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Similarly, select the End Month and End Day values.
Verify these values across all quarters before proceeding.

Click Save to save the added fiscal period for the selected quarter.

Editing the Fiscal Period

1.
2.

Follow the above steps, and double-click on any of the field to edit the values.

Click Save to save the modified changes.

Deleting the Fiscal Period

1.

To delete an existing Fiscal Period, click the corresponding Delete icon.
A confirmation message is displayed. Acknowledge the message.

# Note:

The Fiscal Periods set up in this Fiscal Period Module are associated with the
Legal Entity. This Fiscal Period Attribute is sourced as a part of the Legal Entity.

3.4.2.2.2 Compile Fiscal Periods

To assign a year or a fiscal year to the fiscal periods of the legal entity, use the Compile Fiscal
Periods process. During deployment, the administrator can set up Compile Fiscal Periods
using this procedure, or, after deployment.

ORACLE

To compile a set of fiscal periods for a year, perform the following steps:

1.

To navigate to the Fiscal Period Settings screen, on the Home page, click on User Menu
> Administration > Fiscal Period.

The Fiscal Period Settings page is displayed.
Click the Compile tab.

< Note:

If the fiscal period added in the setup page does not match with the compile date
range, the system displays an error message Error occured while getting fiscal
periods.

Click Start Dateand choose the required start date.

Click End Date and choose the required end date.

# Note:

Once a start date has been compiled, you cannot load data for earlier dates.
Attempting to do so will result in a data ingestion failure due to partition
restrictions.

Click Compile to generate a date dimension and fiscal calendar for the selected date
range.

The selected date range is generated.
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3.4.2.3 Configure Parameters

The Parameters are constant-value, run-time, or current-date variables intended for use with
DFCS. Apart from a seeded (predefined) set of System Parameters, you can add, modify, or
remove them as needed.

e Accessing Parameters

e Parameter Settings

* Defining a Parameter

* Modifying and Viewing a Parameter

e Deleting a Parameter

3.4.2.3.1 Accessing Parameters

To access the Parameters window, follow these steps.

1. To navigate to the Parameters screen, on the Home page, click on User Menu >
Administration > Parameters.

The Parameters Summary window is displayed.
2. Use the search option to search for a specific source.

3. Click Add to create a parameter. For more information, see Defining a Parameter section.

3.4.2.3.2 Parameter Settings

This section describes the parameter settings.

Table 3-5 Fields in the Parameters Window

|
Fields Description

Parameter Name The name for the placeholder that you want to
define. For example, MISDATE, which can be used
as a placeholder for Date.

Parameter Description The description for the parameter you want to
define. Example description: “MISDATE can be
used to substitute the date values for each day,
dynamically, in mmddyyyy format.”

Parameter Type There are three parameter data types:

*  Constant is selected for substituting a
constant value.

. RunTimeis selected for substituting a value,
dynamically, in run time. In the example that is
used here, MISDATE can be selected as Run
Time because it is used to make a substitution
dynamically.

e CurrDate is selected for substituting a value
as Current System Date.

Value Applicable only for Constant data types. Holds the
actual value of the parameter.

3.4.2.3.3 Defining a Parameter

To define a new Parameter, follow these steps:
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1. Click Add on the Parameters Summary screen.
2. Specify the information as described in the Parameter Settings section Parameter Settings.

3. Click Save.

3.4.2.3.4 Modifying and Viewing a Parameter

You can edit or view an existing parameter.

To edit or view a parameter, follow these steps:

1. Click the required parameter from the Parameters Summary screen.
2. Modify the name, description, type, value, default value or date format.

3. Click Save.

3.4.2.3.5 Deleting a Parameter

To delete an existing parameter, follow these steps:

1. Onthe Parameters Summary, click Delete corresponding to the parameter you want to
delete.

Confirm your action.

2. Click Yes to delete the Parameter.

# Note:
You can not delete parameters in the following cases:
e If the parameter is used by any higher object. Example: Connector/EDD.

e If the parameter is pre-seeded.

3.5 DFCS User Journey

Managing data efficiently is key to seamless integration, validation, and accessibility. Follow
these steps to create a well-structured data catalog, map glossary terms, and integrate
connectors for a smooth data management experience.

Figure 3-2 User Journey

Validate and Publish
Connectors

Validate and »l Create Glossary Validate and Publish Create

Publish Catalog Mapping Glossary Mapping Connectors

h 4
A 4

Create Catalog

Steps to Achieve the Outcome:

1. Initiating the Process: Start by identifying what data assets you need to organize.
Determine their purpose, relevance, and how they align with your organization’s goals.

2. Catalog Creation: Use your system or tool to create a structured, searchable catalog that
organizes data assets in an intuitive way.
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3. Glossary Mapping: Link glossary terms to your catalog entries to ensure clear definitions
and alignment with industry standards or internal terminology. This step helps maintain

consistency across your data.

4. Connector Integration: Set up connectors to link your catalog with external data sources
or tools. This enables smooth data flow and ensures seamless integration across

platforms.

5. Validation: Test the functionality of your catalog, glossary mapping, and connectors. Verify
that data flows correctly and is accurate before making it available to others.

6. Publishing: Once everything is validated, publish your catalog so relevant stakeholders
can access and utilize the data for operational or analytical purposes.

3.5.1 Application Navigation across all Screens

The application provides a refreshed Left-Hand Side (LHS) menu, allowing users to navigate
seamlessly. The menu options include Home, Data Catalog, Data Services, Data Controls, and

3.5.2 Catalog Summary

ORACLE

Data Visualization.

The Data Model Summary page displays key model attributes, including entities, their
attributes, and details related to sourcing, processes, governance, data, and data relationships.
Users can utilize the search bar to find specific entities and refine their search using filters such

as Entity Name, Type, and Grain.

The catalog summary page has the below components:

Table 3-6 Catalog Summary

Column

Description

Catalog Status

Catalog Status indicates the current status of the

catalog:

»  Draft — The catalog is still being modified by
the user.

* Validated — The catalog has been reviewed
and validated but is not yet published.

*  Published — The catalog is finalized and
available for use.

Catalog Title

Catalog Title includes the following details:

e Catalog Name - e.g., PBSM Catalog

*  Publish Version Number- Refers to the
unique identifier assigned to a specific version
of a configuration, rule, or dataset that has
been finalized and made available for use in
production or downstream processes.

*  Catalog Description — A brief description (up
to 250 characters)

Catalog Type

Catalog Type includes:

*  Type of Catalog — e.g., Foundation,
Application, BIRD, Seeded

*  Source/Results — Indicates whether the
catalog is a source or results catalog

Created by

Created By includes details of the user who
created or last modified the catalog.
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Table 3-6 (Cont.) Catalog Summary
]

Column Description
Purpose Ingress / Egress
Count Count displays the number of Business Terms

followed by the number of Entities.

The Menu Button (also known as the meatball or
burger button).

# Note:

At least two versions of the catalog must be in the Published state to access the
Audit History option under the ... menu.

3.5.3 View Catalog

The table below outlines the fields and data displayed on the View Catalog screen.

Table 3-7 View Catalog
|

Field Name Description

Name A freeform field where the user enters the catalog
name. This is a mandatory field.

Source A drop-down field where the user selects the
catalog's source. This is a mandatory field.

Source Version Specifies the version of the selected source. This is
a mandatory field.

Published Date for the Source Displays the source's published date. The
maximum allowed date is the current date.

Purpose A drop-down field where the user selects the
catalog's purpose. This is a mandatory field.

Product Category A drop-down field where the user selects the
appropriate product category.

Line of Business A drop-down field where the user selects the
relevant line of business.

Description A freeform field where the user enters a description
for the catalog. This is a mandatory field.

How to use An optional field where the user can provide details

on how to use the catalog or its intended purpose.

3.5.4 Glossary Mapping Summary

The Glossary Mapping Summary page, similar to the Catalog Summary and Connectors,
provides an overview of glossary mappings. It includes the following components:
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Table 3-8 Glossary Mapping Summary User Interface

Column

Description

Glossary Mapping Status

Indicates the current status of the glossary

mapping:

*  Draft — The user is still making changes.

*  Validated — The mapping is validated but not
yet published.

*  Published — The mapping is finalized and
available for use.

Glossary Mapping Title

Includes:

*  Name of the mapping

e Publish version number

» Last updated by and the time since the last
update

Mapping Catalog Type

Specifies:

*  Mapping purpose

*  Mapping type (Primary/Secondary Catalog,
Ingress/Egress based on the purpose)

Mapped Catalog Name and Version

Displays the name and version of the mapped
catalog.

Count

Shows the number of mappings for the respective

glossary:

*  Published & Validated Status — Displays the
count of mappings.

»  Draft Status — Displays Not Validated.

... (Menu Button)

Also called the Meatball/Burger Button. Clicking it
provides the option to View the Glossary

Mapping.

Sorting & Additional Options

e The Glossary Mapping Summary is sorted by Connector Name by default. Users can
change the sorting order using the Sort By button.

3.5.4.1 View Glossary Mappings

The View Glossary Mappings feature allows users to review and manage glossary mappings
within the system. It provides a detailed view of mapped glossaries, their statuses, and

associated catalogs.

Key Features:

» Displays glossary mapping details, including mapping status, catalog type, mapped

catalog name, and version.

* Allows users to filter and sort mappings based on different attributes.

* Provides an option to view detailed mapping relationships between glossaries and

catalogs.

* Users can access this view by selecting the View Glossary Mapping option from the
Menu (Meatball/Burger) button in the Glossary Mapping Summary.

ORACLE
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3.5.5 Connectors

The Connectors Summary interface displays connector details in a structured table format,
providing insights into their status, source, target catalogs, and mappings.

Table 3-9 Connectors Summary User Interface

_________________________________________________________________________________|
Column Description

Status Indicates the current status of the connector:
»  Draft — The connector is still being edited.
*  Validated — The connector has been validated
but not yet published.
. Published — The connector is finalized and
available for use.

Connector Name Displays the name of the connector, along with
details of:
e Last created by
*  Who created it
e Time since creation

Target Catalog & Entity Specifies the name of the target catalog and
entity associated with the connector.

Source Catalog Displays the name of the source catalog linked to
the connector.

Number of Mappings Shows the number of mappings and allows users
to view comments for the Business Term.

3.5.5.1 View Connector Details

The View Connector Details feature offers a step-by-step guided interface to help users
review, configure, and manage connector information efficiently. This section provides all
necessary settings to ensure smooth data transfer between systems.

Table 3-10 Guided Navigation Steps to View Connector Details
|

Step Field Description
Add Connector Details Users begin by entering the following key details about the
connector:

*  Connector Name

*  Description

*  Target Catalog

e Target Entity Name
*  Source Catalog

*  Primary Source Entity
— Upload Connector Data File: Users upload the relevant
connector data file to integrate the source and target
catalogs.

Map Key Business Terms Users map key business terms by:
*  Selecting Target Business Terms
*  Choosing the Source Business Term from a dropdown menu
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Table 3-10 (Cont.) Guided Navigation Steps to View Connector Details

. _______________________________________________________________________________|
Field Description

Step

Direct Mapping

A smart search to find terms by target or source business

terms and entities

A button to add new mappings

A button for Auto-Map to automate mapping

A checkbox for Show Unmapped Business Terms

A checkbox for Show Mapped Business Terms

The main screen displays three key columns:

— Target Catalog Business Terms

—  Source Entity — Allows the user to select a source entity
from the dropdown list.

— Source Business Term — Allows the user to select a
source business term (BT) from the dropdown list.
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Data Foundation organizes metadata for the underlying data model using a shared glossary of
business terms and entities. By sharing business terms across entities, it ensures consistency
in physical data characteristics, such as data types and lengths. It also centralizes data
governance by automatically applying rules, like data quality standards, to any entity that uses
a field mapped to the business model.

For more information, refer to the Balance Reconciliation guide.

4.1 Business Terms

The catalog acts as a central repository for Business Terms (BT), ensuring consistent
definitions for business concepts across the platform. It contains over 10,000 business terms
spanning more than 1,500 entities.

Each business term includes key attributes such as:

* Logical Data Type

* Element Type

+ Seeded/ Custom Business Terms

e Originating Application

* Pll Indicator (identifying if it contains Personally Identifiable Information)

Related business terms share a common definition while maintaining context-specific
relevance for different user roles, ensuring clarity and consistency across the organization.

4.1.1 Business Term Name

ORACLE

The Business Term Name serves as the standardized identifier for a Business Term within
the Data Catalog, ensuring uniformity and clarity across the application. It provides a
concise, human-readable representation that effectively captures the term's purpose and
meaning in a logical and structured format.

Key Characteristics:

e Standardized & Consistent — Ensures uniform terminology across systems.
e Clear & Readable — Designed for both technical and business stakeholders.
* Supports Data Traceability — Facilitates seamless mapping across diverse systems.

For example, a logical name like End of Period Balance clearly conveys its role and
relevance within financial reporting and analysis.

The naming conventions follow best practices, prioritizing clarity, scalability, and alignment
with the associated entity and attributes, ensuring effective communication and governance
across the data ecosystem.
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4.1.2 Business Term Data Type

Data Types provide a framework for classification that defines the nature of data within a
system, ensuring proper interpretation, storage, and manipulation. Each logical data type is
designed for specific use cases, clearly distinguishing how different types of data should be
handled. For instance, types like amount, amount_long, and amount_medium represent
financial figures with varying levels of precision and scale, while currency denotes monetary
values linked to a specific currency. These logical data types help maintain the structure,
integrity, and compatibility of data models across various systems and applications.

Following are some of the Data Types supported in DFCS:

Table 4-1 Mapping of logical data types to Oracle-specific data types
|

Logical Data Type Oracle Data Type
Amount NUMBER (22, 3)
Date DATE

Flag CHAR (1)

Indicator VARCHAR2 (1)
Rate Percent NUMBER (11, 6)
Code_Alphanumeric VARCHAR2 (20)

4.1.3 Business Term Description

A Business Term Description provides a fundamental explanation of a Business Term, offering
a base definition that remains consistent and relevant across all contexts. It outlines the term's
core purpose and meaning, ensuring clarity and uniformity in its understanding and application.
This description serves as a common reference for stakeholders, connecting technical and
business perspectives while remaining independent of specific implementations or use cases.
For example, End of Period Balance could be defined as the account balance at the end of a
reporting period, reflecting a snapshot of financial standing. By delivering a universal and
context-neutral definition, the Business Term Description promotes clear communication,
traceability, and alignment with business objectives across various systems and processes.

4.1.4 Business Term References

Business Term References represent a comprehensive list of all entities within the data catalog
where a specific Business Term is used or mentioned. This includes the source and result
entities that store, process, or propagate the term, enabling complete traceability within the
data architecture. By documenting these references, stakeholders can track the flow and
usage of the term across various system tables, ensuring consistency and alignment. For
instance, the term End of Period Balance might appear in tables related to financial reporting,
account summaries, and transactional data. These references ensure that all data models
adhere to accurate term definitions and interpretations, promoting data integrity and
consistency.

4.1.5 Related Business Terms

Related Business Terms are variations of a core business term, each adapted to a specific
contextual meaning within different business processes or applications. While they share a
common foundational concept, their interpretation or usage may vary to address distinct
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functional requirements. For example, "Country Code" might refer to a standardized ISO code
for global identification, whereas Regulatory Country could represent a jurisdiction-specific
classification used in compliance or regulatory reporting. Defining related business terms
ensures clarity and precision in data usage, fostering effective communication across diverse
teams and systems. This approach enhances traceability, minimizes ambiguity, and
strengthens data governance by connecting related terms under a unified framework while
accommodating their contextual distinctions.

4.1.6 Business Term Contextual Descriptions

The Contextual Description offers application-specific definitions of a Business Term, tailored to
reflect its unique interpretation and usage within particular systems or domains. It
complements the universal Business Term Description by providing context that aligns with the
functional and technical requirements of each application. For instance, the term End of
Period Balance may refer to a customer's account balance at the close of a financial period in
a core banking application, while in the insurance domain, it could represent the balance
remaining on a policyholder’s account. These tailored definitions ensure clear communication,
promote accurate data usage, and ensure that the term’s meaning aligns with the operational
and analytical needs of each system. By providing targeted descriptions, the Contextual
Description helps bridge potential gaps in understanding and maintains consistency across
diverse applications.

4.1.7 Business Term Data Quality

Data Quality Rules establish the criteria and constraints necessary to ensure the accuracy,
consistency, completeness, and reliability of data associated with a Business Term. These
rules define validation checks, threshold limits, and compliance conditions that data must meet
to maintain its integrity across systems and processes. For example, for the term End of
Period Balance, data quality rules might include ensuring the value is non-negative, matches
the sum of debits and credits for a reporting period, and corresponds correctly to the
associated account type. These rules are applied at both the table and attribute levels in the
data model to detect anomalies, prevent errors, and ensure compliance with regulatory or
business standards. By implementing strong Data Quality Rules, organizations can uphold
data integrity, foster trust in their data assets, and enable accurate decision-making.

4.1.8 Business Term List of Values

The List of Values (LoV) for Business Terms consists of a predefined set of acceptable values
or categories associated with a specific Business Term. These values establish clear
boundaries for data entry, ensuring consistency, standardization, and accuracy across systems
and processes. For example, the Business Term, Account Status might have a List of Values
such as "Active, Inactive, Closed, and Suspended. The LoV is typically managed in lookup
tables within the data model and plays a key role in validation, reporting, and analysis. By
defining and enforcing the List of Values, organizations can reduce errors, simplify data
interpretation, and ensure consistent application of the term across various operational and
analytical contexts.

4.1.9 Business Term Use Case

ORACLE

The Business Term Use Case documents the specific applications of a Business Term across
various systems, illustrating how the term supports distinct business processes and analytical
needs. This mapping ensures that the term’s definition and usage align with the objectives of
each system. For example, the term End of Period Balance might be used in Profitability
applications to calculate income and expense margins, in Asset Liability Management to
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evaluate balance sheet stability, and in Liquidity Risk management to assess cash flow
sufficiency. By outlining these use cases, the Business Term Use Case promotes accurate data
alignment across systems, facilitates seamless integration, and ensures the term is effectively
utilized to achieve both operational and strategic goals.

# Note:

Once the term’s definition and usage are aligned with the intended objectives, you
can provide your comments, including any relevant details related to the definition.

4.2 Entities

Entity refers to a distinct and logically defined data object that represents a set of data in
banking operations. Entities are used to structure and organize data within a database or data
warehouse and are critical to maintaining consistency, traceability, and clarity in data
management. The entity contains business terms. The granularity of the entity is decided by
Primary Key which can be one or many business terms. The entity will hold the data from
various source systems or data within Data Foundation.

4.2.1 Line of Business

ORACLE

Data Catalog in DFCS provides comprehensive support for data for the following lines of
business.

e Retail and Personal Banking

*  Wholesale Banking

* Investment Banking and Wealth Management
*  Treasury

e Ancillary Lines of Business

It also has rich coverage for Reference and Market Data that are needed by the lines of
business.

Additionally, it supports a rich dimensional model for storing results for a comprehensive set of
use cases across Finance, Risk, and Compliance domains.

Table 4-2 Line of Business
]

Category Total No. of Entities
Retail and Personal Banking 48

Wholesale Banking 81

Investment Banking and Wealth 50

Management

Treasury Services 21

Ancillary Lines of Business 23

Reference and Market Data 23
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4.2.1.1 Grain Classification

Data Catalog in DFCS provides the grain classification. Each grain can have one or more
entities. Grains represent the smallest, indivisible units of financial data that form the
foundation for processing and analyzing entities. These grains ensure granular-level detail and
traceability across various entities. Examples include entries such as Customer Account, which
identifies individual customer financial details, and Customer Account Transactions, which
record specific financial movements. Date serves as a temporal dimension for tracking
transaction timelines, while Exchange Rates provide currency conversion details essential for
multi-currency operations. General Ledger Data consolidates financial information at the
account level for reporting and analysis, complemented by Management Ledger for managerial
insights. Other granular elements, such as Group Insurance Policy Beneficiary and Group
Insurance Summary, capture policy-specific details, while Policy Claim, Policy Claim
Transaction, and Policy Commission Transactions detail insurance operations. Finally, Party
Consent represents customer authorization for processing sensitive financial data. These
grains collectively create a robust and detailed framewaork for accurate and transparent
financial accounting.

Some of the examples for grain counts are Customer Accounts, General Ledger Data.

4.2.1.2 Entity Type Classifications

ORACLE

Entity type classification is a structured method for organizing entities based on their roles and
functionality within a data catalog. Each entity type plays a distinct role in ensuring seamless
data processing and analysis. Within this framework, the distribution emphasizes the
importance of each classifications:

- Dimension Results: These entities offer contextual and descriptive master data.

« Fact Results: These entities store transactional and quantitative data that serve as the
foundation for performance measurement and reporting.

* Point of Integration: These pivotal entities act as connectors, ensuring the smooth
exchange and alignment of data across different Apps.

* Processing: These entities handle computational logic and business operations,
transforming raw data into actionable insights.

e Staging: The most numerous, these entities store raw or intermediate data, playing a vital
role in validation, enrichment, and data transformation workflows.

This classification ensures each entity is effectively utilized for its specific function, fostering
efficiency and consistency in data-driven processes.

Table 4-3 List of Entity Type
]

Entity Type Count
Dimension Results 776
Fact Results 554
Point of Integration 3
Processing 9
Staging 1201
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4.2.2 Product Processor Entities

The classification of financial products based on their processor categories and catalog entities
is crucial for organizing and managing data within financial systems. This systematic approach
categorizes various financial instruments and contracts across different domains, ensuring
accuracy and consistency. By organizing products into distinct categories such as assets,
derivatives, liabilities, and off-balance sheet assets, this classification helps improve data
accuracy, ensure regulatory compliance, and streamline reporting. Examples of such
classifications include assets like loan contracts, overdraft accounts, and investments;
derivatives like credit derivatives, swaps, and options; liabilities such as term deposits and
borrowings; and off-balance sheet assets like commitments and letters of credit. This
structured framework supports consistent product processing, facilitates seamless integration
across financial systems, and ensures clarity in the representation of financial data.

Some of the core products of banking are:
* Loan Contracts

e Term Deposits

e Option Contracts

e Letter of Credit

4.2.3 Reference Data Entities

Reference data in a data catalog serves as a foundational component that standardizes and
contextualizes data across systems and processes. It represents relatively static datasets used
to provide consistency, alignment, and meaning in data-driven workflows. Examples of
reference data include Catalog Entity, which organizes and identifies key entities; Currency,
which defines monetary units for financial transactions; and Country, which standardizes
geographical identifiers. Additional reference data like Forecast Exchange Rate provides
predictive currency values essential for planning and analysis, while Macro Economic Variables
and Macro Economic Variable Details capture high-level economic indicators and their granular
components, respectively. By maintaining centralized, accurate, and easily accessible
reference data, the data catalog ensures reliability, fosters interoperability, and enhances the
integrity of analytics and reporting processes.

Some examples of the catalog entities are Currency, and Country.

4.2.4 Results Area Entities

ORACLE

Data Foundation has ability to provide data for analytical applications in finance, risk, and
compliance domains. It also has well-designed placeholders to store results data from these
applications.

# Note:

Before proceeding with this configuration, ensure that the Currency Exchange
Module is executed. Refer to Configuring Reporting Currency Attributes Before
Executing PMF.

Key Features of the Results Area Design
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* Design: The Reporting Area data model is a dimensional data model. This means that it

consists primarily of central fact tables (de-normalized), related to multiple dimension
tables, also called a Star Schema. Additionally, the dimension tables are shared across the
star schemas in the reporting mode, meaning they are Conformed Dimensions.

e Support for multiple scenarios of analysis: The reporting data model has been

designed to support scenario analysis of the sort required by financial institutions that need
to measure and report risk and performance under a variety of economic scenarios. The
reporting model provides support for this kind of analysis via a Run Dimension — it allows
analytical engines to load multiple result sets identified by scenarios.

e Support for Cross Functional Reporting: The third critical feature of the Reporting area
design is the support for cross-functional reporting. Majority of emerging needs relate to
the analytical problems at the intersection of the distinct areas of Risk, Performance,
Customer Insight, and Compliance. This is addressed amply by the results area of Data
Foundation.

4.3 Catalog Extensions

ORACLE

Extension of data catalog is carried out with due consideration for Change Management
through an Issue-Action Management feature. Final step of Change Management includes a
built-in administrator level oversight for publishing the catalog changes into actionable
metadata as per a schedule that does not conflict with the data pipelines under execution. For
further information about how to browse and extend the Data Catalog, refer to the Oracle®
Data Foundation Cloud Service Data Platform guide.
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Data Integration

This section outlines how data is exchanged between the Financial Services Data Foundation
Cloud Service for Banking and external systems. This is achieved through the logical
abstraction of the Data Catalog, which is exposed as Application Data Interfaces (ADIs). Users
can define External Data Descriptors (EDDs) through the interface, enabling seamless
mapping of EDDs to ADIs and the creation of Connectors for efficient data integration.

For more information, see Oracle® Financial Services Data Foundation Cloud Service for
Banking Data Integration Guide.

5.1 File Operations

ORACLE

The file operation process enables you to add files that must be processed to the object store.
You can upload any CSV, XLSX, and Text file that you wish to be stored in the object store,
which can be processed later.

To upload a file, complete the following steps:
1. Onthe DFCS home page, click the User Menu and select Administration.
2. Click File Operations.
3. Click Upload File.
The Generate PAR URL to upload file window is displayed.
4. Enter the File Name.
5. Select the File Type from the drop-down list.
The supported file types are: CSV, XLSX, Text, and Zip.

6. Enter the file size (in bytes) as seen on the disk.

¢ Note:

Enter a number between 0 and 8,053,063,681. The input should be no more than
255 characters. Ensure the value matches the following format: '[a-zA-Z0-9][a-
ZA-Z0-9.-_:]*[a-zA-Z0-9]'.

7. Click Add to add more files, and repeat the steps.
8. Click Delete to remove files.
9. Click Generate.

This generates a PAR (pre-authenticated request) URL which is valid for 24 hours. This
PAR URL is used to upload the file into the object store.

10. An entry for the PAR URL you just created appears on the File Operations page.

The search feature provides you multiple options to search for a file based on name,
creation date, and so on. You can also sort the list by name and creation date in ascending
or descending order.

You can download a file using REST API.
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5.2 Background and Coverage

ORACLE
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Data Foundation comes pre-configured with capabilities for assimilating data for the following
products. Assimilated data will act as single source of truth for all product related data. Data
Foundation also supports extensions of the underlying platform to support unique needs of the

customer not available in the pre-configured version.

While customers are expected to setup sourcing of data using EDDs, Data Foundation ships

with pre-built results area connectors for the following products.

Annuity Contracts
Bill Contracts
Borrowings

Cards

Casa (Current/Checking Accounts, Savings Accounts)

Commitment Contracts
Commodity Contracts
Correspondent Accounts
Credit Derivatives
Forwards Contracts
Futures Contracts
Foreign Exchange Contracts
Investments

Letter Of Credit Contracts
Leases Contracts

Loan Contracts

Merchant Cards
Overdraft Accounts
Option Contracts
Payment Settlement Accounts
Prepaid Cards

Repo Contracts

Swaps Contracts

Term Deposit Contracts
Other Assets

Custodial Accounts
Trusts

Trading Account

Connectors for Islamic Banking products too are supported out-of-the-box.

— ljarah Accounts

5-2



Chapter 5
Data Sourcing

— lIstisna Accounts

— Mudarbah Accounts
— Murabahah Accounts
— Musharkah Accounts
— Salam Accounts

—  Sukuk Accounts

5.3 Data Sourcing

ORACLE

Data Sourcing refers to the processes of acquiring data from both internal and external
systems (data sourcing) and transferring it to other environments or applications. Data
sourcing involves identifying, extracting, and collecting data from various sources, such as
transactional systems, third-party providers, or data warehouses. This data is then processed
and integrated to support business operations, reporting, or analytics. In contrast, data egress
deals with the movement of processed data from its original system or database to other
platforms, systems, or end-users. This may include sharing data with downstream applications,
regulatory reporting systems, or external partners. Data sourcing must be carefully managed to
ensure data quality, security, and compliance with regulatory standards, particularly when
handling sensitive financial or customer information. Effective strategies for data sourcing is
vital to ensuring that the right data is delivered to the right destinations in a timely, secure, and
accurate manner. In DFCS, data sourcing is facilitated through Connectors using External Data
Descriptors for each entity.

For more information on External Data Descriptor and Connectors, see Data Integration guide.
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Data Controls

6.1 DQ Checks

Data Quality Framework consists of a scalable rule-based engine that uses a single-pass
integration process to standardize, match, and duplicate information across global data. This
framework within the infrastructure system facilitates you to define rules and execute them to
query, validate, and correct the transformed data existing in an Information Domain.

Data Catalog Contents include Data Quality Check Rules and DQ Groups (logical grouping of
DQ rules). These Rules are defined at the Business Term and Entity Level, and seeded as a
part of the Data Catalog Content.

For instructions on how to create/edit/delete DQ rule, please refer to FRC Data Platform user

guide.

The following is a list of pre-configured Data Quality rules included in the offering:

In the banking domain, data quality is essential for ensuring the integrity, accuracy, and
reliability of financial information that supports decision-making, compliance, and operational
efficiency. To maintain high standards of data quality, various validation rules are applied to the
data. These rules help identify and prevent errors, inconsistencies, and incomplete data entries
that could lead to incorrect business processes or regulatory violations. Common data quality
rules used in banking include Prebuilt Business check, list of values, referential integrity
checks, range checks, and more. Below is an overview of these rules, along with examples
specific to the banking domain, which highlight their importance in managing data effectively
across banking systems.

Data Quality Rules

Definition

Example

Objective

Prebuilt Business
Checks

Prebuilt Business check
is a rule based on
business specific or
unique conditions that
don't fall under standard
data quality rule
categories.

A customer's Account
Balance must not be
negative if the account
type is 'Savings'.

To apply business-
specific logic that isn't
captured by standard
validation rules.

List of Values or Code
Check

This rule ensures that a
field contains a value
from a predefined list of
valid values, such as
bank codes, account
types, or country codes.

The Account Type must
be one of the following:
‘Checking’, 'Savings',
‘Credit".

To ensure only valid and
standardized data
entries are used in the
system.

Referential Integrity
Check

Ensures that
relationships between
different tables or data
entities are correct,
typically by checking
foreign keys against
primary keys.

The Loan ID in the
Payment History table
must exist in the Loan
Account table.

To prevent orphaned
records and ensure that
linked data entities are
consistent across the
system.

6-1



Chapter 6
Balance Reconciliation

Data Quality Rules

Definition

Example

Objective

Column Reference or
Specific Value Check

Ensures that the value in
one column is consistent
with values in another
column or a related data
set.

If the Account Status is
'Closed', then the
AccountBalance must be

Zero.

To ensure that business
logic between columns is
followed correctly.

Generic Check

A general validation
check applied across
various data sets, such
as length checks or
format checks, which
doesn't belong to a
specific category.

The IBAN number
should be 22 characters
long and contain only
alphanumeric
characters.

To apply basic checks
that are common across
different data sets.

NULL Value Check

Verifies that required
fields are not missing,
meaning they are not
NULL.

The Customer Name
field must not be NULL
for all active customer
records.

To ensure that essential
customer or transaction
information is always
captured.

Range Check

Verifies that data values
fall within a valid range,
which is commonly used
for numeric fields or
dates in banking
systems.

The Credit Score must
be between 300 and

850.

To ensure that data,
such as credit scores or
loan amounts, falls within
realistic and acceptable
ranges.

BLANK Value Check

Ensures that fields do
not contain blank or
empty string values,
which may represent
missing or incomplete
data.

The Loan Amount field
must not be blank or
contain only spaces in a
loan application.

To prevent incomplete
data from being entered
into critical banking
systems, ensuring full
and valid records.

These banking-specific examples help ensure that critical financial data is correct, consistent,

and adheres to industry standards for data integrity and compliance.

In DFCS the following number of rules are bundled /autogenerated in each category.

Table 6-1 Number of Tools that are bundled

Check Type No of Rules
Prebuilt Business Checks 801

List of Values or Code Check 3266
Referential Integrity Check 7610
Column Reference or Specific Value Check 338

Generic Check 262

NULL Value Check 279

Range Check 11

BLANK Value Check 6

6.2 Balance Reconciliation

Balance Reconciliation reconciles the balances from the operational systems of a bank with
the balances maintained in General Ledger (GL) of the bank. The bank's operational data are
sourced into standard product processor entities or other operational data entities used by the

ORACLE

bank.
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The balances in the GL of a bank are the ones that are audited and duly certified by internal
and external auditors. Hence, considered to be the final version of the truth in a bank.
Therefore, all data extracted from any other operating system of a bank must be reconciled
with the balances maintained in the GL to ensure they are complete, accurate, and
comprehensive. It acts as an authentic and reliable base for any further decision-making.

DFCS' GL Reconciliation has pre-configured definition process. Currently DFCS supports
below type of reconciliation:

e General Ledger to Product Processor

# Note:

For more information on Balance Reconciliation, see Balance Reconciliation in the
Data Controls user guide.
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Data Operations

Process Orchestration is a design and execution service that enables process pipeline
developers to implement pipelines modeled by business analysts. Process pipeline developers
use this framework to orchestrate Run Pipelines within DFCS, and also to design the artifacts
that are used in the pipelines.

The Process Modeller and the Process Monitor are two key parts of Process Orchestration.
The Process Modeller is used to model pipelines. It aids in representing the various artifacts
required for modeling and provides implementation details of the DFCS process artifacts. The
Process Monitor is used to monitor instantiated pipelines of DFCS.

DFCS supports orchestration of the Run Pipeline, which is any orchestrated pipeline consisting
of DFCS tasks and service calls that run within the DFCS context.

# Note:

For more information on Run Pipeline, refer Run Pipeline.

7.1 Account Load Run Map Population

ORACLE

The Account Load Run Map Population process is a feature in Data Foundation Cloud Service
(DFCS) that manages and organizes the loading of intra-day accounts, particularly for
incremental and snapshot updates.

This section provides an overview of the operation process.

1. Intra-Day Accounts: Accounts are updated within a day based on specific activities or
events, and the system captures these changes efficiently.

2. Incremental and Snapshot Updates:

* Incremental Updates: Only the changes that have occurred since the last update are
captured (e.g., modifications or new records such as transactions or account status
changes).

e Snapshot Updates: A full view of the data at a specific point in time is captured,
including all account data, regardless of whether changes have occurred since the last
snapshot.

3. Load Run ID: Each account load (whether incremental or snapshot) generates a unique
Load Run ID. This ID is used to track, distinguish, audit, and ensure accurate tracing of
each load process.

4. Map Population: The loaded account data is mapped to a predefined structure or schema
within DFCS, ensuring it is correctly placed in the appropriate tables, formats, or structures
for further processing or reporting.
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7.1.1 Benefits

Chapter 7
Configuring Reporting Currency Attributes Before Executing PMF

Data Traceability: The Load Run ID provides an audit trail for each load operation,
ensuring traceability and transparency.

Efficient Data Handling: The system can process intra-day account data efficiently by
only loading necessary changes with incremental updates while maintaining full data
integrity with snapshots.

Consistency: The process ensures that the data is loaded into DFCS consistently and
accurately, making it ready for further downstream applications such as regulatory
reporting, analytics, and other business processes.

In essence, the Account Load Run Map Population process is key in handling dynamic,
intra-day account updates within DFCS, ensuring both data completeness (via snapshots) and
efficiency (via incremental updates).

7.2 Configuring Reporting Currency Attributes Before Executing

PMF

Pre-requisite:

Before executing Result Area Population PMF, you must configure the necessary settings to
ensure that the Reporting Currency Attributes in the Common Account Derived Attributes
Entity are populated with accurate conversion values. The Currency Exchange Module must
be executed before proceeding with this configuration.

1.
2.
3.

Navigate to Administration - Click Run Execution Parameter.
Click Add Run Execution Parameter.
Enter the following values in the popup screen:

- Parameter Name — Specify the execution parameter configuration name (required for
executing Result Area Population PMF).

- Description — Provide a brief description of the execution parameter configuration.

e Currency Rate Type — Select an appropriate value from the Currency Rate Type
Dimension.

e Currency Rate Nature — Select an appropriate value from the Currency Rate Nature
Dimension.

e Currency Rate Version — Choose a value from the Currency Rate Version
Dimension.

e Currency — Specify the target currency for conversion.
Click Save.

By completing this setup, the system will accurately derive and populate the Reporting
Currency Attributes for correct financial reporting.

7.2.1 Results Area Entities

Data Foundation has ability to provide data for analytical applications in finance, risk, and
compliance domains. It also has well-designed placeholders to store results data from these
applications.

ORACLE
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# Note:

Before proceeding with this configuration, ensure that the Currency Exchange
Module is executed. Refer to Configuring Reporting Currency Attributes Before
Executing PMF.

Key Features of the Results Area Design

Design: The Reporting Area data model is a dimensional data model. This means that it
consists primarily of central fact tables (de-normalized), related to multiple dimension
tables, also called a Star Schema. Additionally, the dimension tables are shared across the
star schemas in the reporting mode, meaning they are Conformed Dimensions.

Support for multiple scenarios of analysis: The reporting data model has been
designed to support scenario analysis of the sort required by financial institutions that need
to measure and report risk and performance under a variety of economic scenarios. The
reporting model provides support for this kind of analysis via a Run Dimension — it allows
analytical engines to load multiple result sets identified by scenarios.

Support for Cross Functional Reporting: The third critical feature of the Reporting area
design is the support for cross-functional reporting. Majority of emerging needs relate to
the analytical problems at the intersection of the distinct areas of Risk, Performance,
Customer Insight, and Compliance. This is addressed amply by the results area of Data
Foundation.

7.2.2 Result Area Entity Data Population Run Execution

The Entity Data Population process involves filling and validating data for entities within the
result area. This ensures accurate mapping, integration, and usability of entity data.

1.
2.

6.

Navigate to Data Operations and search for Results Area Entity.

On the results window, click on the menu button, and then select Execute Run.
The Execution window appears.

In the Execution window, select the Execution Type as Without Parameters.
Enter the Object ID. The Object ID is a unique identifier.

Enter the RUNPARAM (in JSON format). For example, Run Param:
{"FIC MIS DATE":"2024-09-01", "RUNPARAM":"TEST"}.

< Note:

The RUNPARAM value must match the execution parameter configuration
name, ensuring it is identical to the Parameter Name specified in the executing
Configuring Reporting Currency Attributes Before Executing PMF.

Click Execute.

7.2.3 Results Area Load Batch

The Results Area Load Batch is a process in Data Foundation Cloud Service (DFCS) that
facilitates the loading of fact results from the staging results area into the final results area

ORACLE
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for reporting purposes. This process ensures that the data is properly processed, organized,
and available for consumption by downstream reporting applications.

1. Loading Fact Results:

Fact results are essentially the processed data that is typically used for reporting,
analytics, and business intelligence purposes.

These facts could include various financial and transactional data points, such as
accounting entries, general ledger (GL) data, currency exchange rates, and so on.

The data in the staging area may be raw, intermediate, or partially processed, and the
Results Area Load Batch is responsible for moving it into the final results area where
it is aggregated, cleansed, and made ready for reporting.

2. Run Surrogate Key:

The Run Surrogate Key is a unique identifier that allows for tracking and managing
multiple load runs.

Since data loads may occur multiple times a day, the surrogate key helps to
differentiate between different runs of the same type of fact data (e.g., accounting
entries or GL data). This ensures that even if the data loads are similar, each load can
be identified and handled independently.

The surrogate key is important for data traceability, ensuring that each batch can be
traced back for auditing, version control, and historical analysis.

3. Examples of Fact Loads:

7.2.3.1 Benefits

Load Fact Accounting Entries: This process loads detailed accounting data, which
includes financial transactions that affect accounts, such as debits, credits, account
balances, and other related financial details.

Load Fact GL Data: Loads general ledger data, which is aggregated and provides a
summarized view of financial transactions by categories such as account codes,
periods, and balances.

Load Fact Currency Exchange Rates: Loads data regarding the exchange rates
between different currencies, which are essential for converting financial amounts into
consistent currency representations across different regions.

Load Fact Accounting Entries Header: This is the header-level data associated with
accounting entries, which may include metadata such as transaction type, reference
numbers, and other summary information.

e Continuous Data Updates: By supporting multiple load runs per day, the system ensures
that the most up-to-date fact data is always available for reporting purposes.

- Efficient Tracking and Management: The use of a Run Surrogate Key.

ORACLE
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Data Visualizations

Data Foundation Cloud Service (DFCS) provides users with a powerful Data Visualization
feature to visualize loaded source data and processed results data directly via user interface.
The process of data visualization is very user friendly and does not require any query language
skills like SQL. Custom visualization report can be generated via direct drag and drop feature
and can further be used to analyze data insights effectively. This feature enables users to
explore and visualize data across the following key sections:

Source Data Visualization

Results Data Visualization

Pre-Built reports and KPIs

Data Quality dashboard

General Ledger Reconciliation dashboard
Custom attributes

On the DFCS Home page, navigate to Data Visualization > View pre-defined reports.

8.1 Data Browser

The Data Browser is an interactive tool that allows you to explore and interact with the data
stored in the system. It provides a real-time view of the data entities and their attributes,
making it easier to visualize.

To access these reports, navigate through the following path:

1.

2
3.
4

Navigate to the Data Foundation for Banking Home page > Data Visualisation.
Under the Data Visualisation section, click View Pre-built Reports.
From the LHS menu, select Catalog > Shared Folders.

From the Shared Folder window, select Data Foundation Reports type. The following
Data Foundation Reports are displayed and each type displays various reports.

*  Source Data

e Use case Analysis
e Pre-built Reports

e Right To Forget

e Reports Glossary

« Key Performance Indicators

8.1.1 Source Data Visualization

Source data visualization enables you to view raw data loaded into staging entities post data
loading. Data visualization is supported for pre-built datasets and is best suited for scenarios
where a query will return a few rows of the output.

ORACLE
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Source Data Visualization is intended to provide authorized users tactical access to data that is
moved into DFCS Data Store. Such tactical access is used for verification purposes, primarily
in Test and Non-Production instances.

There are two ways to view source data:
1. Custom source data view

2. Pre-configured source data View

8.1.1.1 Custom Source Data View

User can create new visualization reports to view data for specific attributes that are not a part
of pre-configured staging data visualization.

User can create new visualization reports to view data for specific attributes that are not a part
of pre-configured staging data visualization.

Create (top right of screen) -> Workbook -> Datasets -> Search for relevant source entity.

® Navigate to Create on top right of the screen, select Workbook > Datasets > Search for
relevant entity.

Figure 8-1 Custom source data view
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Figure 8-2 Custom source data view 2
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Figure 8-3 Custom source data view 3
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8.1.1.2 Pre-configured source data View

User can view subset of staging data that is loaded from the source systems for a selected
pre-configured set of attributes. This is a restricted view that allows users to view only selected
attributes that hold the most commonly referred data. The benefit of having this restricted view
is faster data load and focused visualization of important data only. The solution also
aggregate queries with appropriate filters for use against any dataset.

Data Visualization provided with DFCS can be accessed via following navigation paths:

® Home -> Catalog -> Shared folders -> Data Foundation reports -> Source Data -> Banking
-> Subject Area -> Individual source entity.

Figure 8-4 Pre-configured source data view
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Figure 8-5 Pre-configured source data view 2
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8.1.1.3 Exporting data

Data visualization (source data or results data) can be exported in various format like excel,
csv, PowerPoint and image.

Steps to export data:
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1. Right click on Data -> Edit-> Copy -> Paste to excel.

2. Right click on Data -> Export -> File -> Chose format (PowerPoint, image, pdf or csv).

Figure 8-6 Party Financials
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Figure 8-7 Party Financials Export
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Figure 8-8 Party Financials File
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8.1.2 Results Data Visualization

ORACLE

DFCS supports result entities’ data visualization based on pre-defined out-of-the-box datasets
called subject areas. Each subject area is a pre-configured dataset that brings together all fact
entities of similar grain and includes pre-defined relationships with their related dimension
entities. Customized results data visualization canvases can be created by user to enable
them or other staff to access and analyze results data more as per their specific requirement
for a given subject area. The service offering also includes pre-built sample dashboards called
Pre-Built reports for user to view results data.

Results Data visualization represents view of results (fact) data either via tables or via various
graphics forms such as charts, pie graphs, scatter plots and other such sophisticated forms.
Visualization can be for out-of-the box sample dashboards or custom requirements of user.
There are many visualizations options that help user display data in the form of tables or
various graphs and charts. Visualizations options include but are not limited to tabular data,
pivots, bar graphs (Vertical, horizontal, stacked bar, etc.) pie charts, line graphs, scatter
graphs, tree map, etc. This makes it easier for user to spot patterns and trends in massive data
sets that are hard to identify with the naked eye. These interactive dashboards can be created
by a business user to enable self and other staff to access information more easily, as data
visualizations created by one user can be shared with other users too. Each graphical element
has the potential to provide granular information that updates all visualizations in the
dashboard as the user drills down into finer and finer detail even on a single given
visualization.

To summarize, the main goal of results data visualization is to:
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Make results (fact) data available for user for each subject area or granularity.

Make results (fact) data available for user for tabular view without the need to write
complex SQL queries or without any dependency on any third party application.

Make results (fact) data available via graphic visualizations for data analysis and MIS
reporting.

Access out of the box sample pre-built visualizations and pre-built reports for each subject
area.

Access granular data via drill through.

Share data visualizations custom created by one user with other users within the
organization.

Access sample Key performance Indicators (KPIs).

Options to export reports to multiple formats such as Microsoft Excel, Microsoft
PowerPoint, PDF, and so on.

Visualization options can be seen in LHS top under the Visualizations button.

Figure 8-9 Visualization
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There are two ways to view results data:

1. Custom results data view

2. Pre-configured pre-built reports

8.1.2.1 Subject Area

A Subject Area (SA) is a pre-configured dataset that includes all fact entities (along with their
attributes) and their associated dimension entities, relevant to a specific functional domain.

Key Features:

Domain-Specific Data Access — Provides users with a structured view of entities and
attributes needed for a particular functional area.

Fact and Dimension Entities — Includes key data points (fact entities) and their contextual
details (dimension entities).

Supports Multiple Granularities — Most Subject Areas contain entities of the same
granularity, but some may include multiple levels.

Example:
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The Accounts Subject Area allows users to access all account-granularity data,
including dimensions such as product type, party type, and account rating.

While most entities follow the account grain, some may have different granularities, such
as account-rating or account-address grain.

For optimal data extraction, users should first review the Subject Area Granularity to
ensure they are working with the correct level of detail before extracting data.

8.1.2.2 List of subject areas supported

The subject areas will be enhanced in future releases to accommodate for more specific
granularities.

Below is the list of subject areas currently supported:

Accounts

Credit Line

Data Quality Results
Financial Accounting Entries
GL Reconciliation

Financial Ledger

Mitigants

Party Details

Placed Collateral

Transactions

< Note:

Subject Areas come as part of out-of-the-box configuration and can't be created
or modified by user. For any requirement related to subject area update, user will
need to raise a support request.

8.1.2.2.1 Subject Area Glossary

Each Subject Area has a pre-defined glossary that provides essential documentation for
users, helping them understand data structure and relationships.

ORACLE

List of all result entities included in the subject area
Entity granularity of each result entity based on the primary keys
Attribute name and detailed attribute description for all primary keys

Entity relationships that define relation of attributes with related dimension entity and the
related attribute

The glossary helps users determine which attributes can be combined in a single visualization
for meaningful insights. A single visualization should include attributes of similar granularities to
avoid Cartesian join issues, which can lead to data misinterpretation.

For Example:
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Attributes from Common Account Summary and Loan Account Summary can be used
together in a single visualization.

* End of Period Balance (EOP Bal) for loans should not be combined across Account
Rating Details and Common Account Summary.

* If an account has three credit ratings from different agencies, it will have three rows
for the same account, repeating the EOP Bal value.

»  This could lead to the EOP Bal being aggregated incorrectly (e.g., tripled for a single
account).

Subject Area Glossary can be accessed as below:

® Home -> Catalog -> Shared folders -> Subject Area Glossary

Figure 8-10 Subject Area Glossary
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8.1.2.3 Custom results data view

User can create new visualization reports to view data for specific attributes of results entities.
Steps to view custom source data in Data View Ul are as below.

® Top Right Corner -> Create -> Workbook -> Subject Area -> Choose Subject Area -> (new
Workbook is created)

Figure 8-11 Custom results data view
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Figure 8-12 Add Dataset
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Figure 8-13 New Workbook

Each workbook can have multiple Canvases, similar to the way excel workbook has

multiple sheets.
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Each Canvas can have multiple visualizations, similar to the way single excel sheet can
have multiple graphs in single sheet. Maximum of 6 visualization is recommended in a
single canvas for optimum system performance.

User can drag and drop attributes required for analysis from left hand side (LHS) under
data button. This process is very user-friendly and doesn't require the abilities of SQL
query writing to fetch data.

Figure 8-14 Data button

8 L ~

Attributes are displayed in data tab in following order:

e Fact entities in alphabetical order based on Entity logical name

- Dimension entities based on alphabetical order

e Attributes displayed in alphabetical order within fact and dimension entities

e ‘My Calculations’ on left bottom will display any calculation formulae added by user
Users can add calculation formula for value measures displayed in the view.

Users can also save and share these custom report created with other users.

8.1.2.4 Exporting Data

ORACLE

Data visualization (source data or results data) can be exported in various format like excel,
csv, PowerPoint and image.

Steps to export data:
1. Right click on Data -> Edit-> Copy -> Paste to excel.

2. Right click on Data -> Export -> File -> Chose format (PowerPoint, image, pdf or csv).
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Figure 8-15 Data visualization Party Financial Details
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Figure 8-17 Data visualization Party Financial Details Export File
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8.1.2.5 Sample Key Performance Indicators (KPIS)

Key Performance Indicators (KPIs) are pre-calculated values in the solution that measure
performance for a specific objective over time. KPIs provide measurable metrics for
businesses to track over time and gauge their progress. They also help with insights that help
Fl business leaders to make data driven decisions, measure their performance and plan at a
strategic level.

Some sample KPIs are packaged in out-of-the box product and can’t be modified by the user.
However, user has the flexibility to create their own KPlIs.

The solution aims to cover most indicators used across the banking and Fl industry.
Currently, the solution supports Account based KPlIs for Loans and Deposits.

To access these visualizations, navigate through the following path:

1. Home - Catalog - Shared Folders . Data Foundation Custom Reports — Key
Performance Indicators -, Balance Sheet

The dashboard has a default set of filters as shown below and further filters can be added by
the user.
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Figure 8-18 Sample Key Performance Indicators (KPIs)

= Legal Entity Name Fiscal Year Month Date  # Line Of Business Name  # Business Unit Name % Branch Name
Al Al A Al A

@

Al el Al

To access these visualizations, navigate through the following path: Home - Catalog -
Shared Folders — Data Foundation Custom Reports a Key Performance Indicators a

Balance Sheet The dashboard has a default set of filters as shown below and further filters
can be added by the user.

8.1.2.5.1 Sample Loans and Deposits KPIs

KPIs related to Loans and Deposits KPIs are included as part of out of the box product. Users
can create their own KPIs and visualizations for that for their custom requirements.

# Note:
This user guide does not explain individual visualization chart details, their calculation
logic and their interpretation as that is included as part of KPI glossary.

8.1.2.5.1.1 End of Period

This report presents a comparative analysis of Total Loans and Total Deposits as of specific
date, allowing users to examine the balance sheet dynamics and assess the relationship

between lending activities and deposit mobilization. Please refer to KPI Glossary in solution for
further details.

Users have options to choose values for pre-configured filter attributes or add their own filters.

Figure 8-19 End of Period
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8.1.2.5.1.1.1 Time Series
This report gives a view into trend analysis of total outstanding loans, deposits and
investments over multiple time periods and how they have changed over time. It gives
breakdown of deposit types accepted and loan types floated in the market. It also shows
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snapshot of Debt and Equity Investments over multiple time periods. Users have options to
choose values for pre-configured filter attributes or add their own filters.

Figure 8-20 Time Series
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8.1.2.5.1.1.2 Deposit Growth
The Deposit Growth Visualization provides an insightful analysis of a financial institution's
deposit portfolio, focusing on key deposit categories of Current or check-in Account and
Savings Accounts and their movement over time periods. By offering detailed insights into
CASA ratio, total deposits, CASA deposits, and term deposits, users can effectively track and
analyze growth trends across different deposit categories.

Figure 8-21 Deposit Growth

8.1.2.5.1.1.2.1 Loans Growth
The Loans Growth Report offers a detailed analysis of loan, credit cards and overdraft
performance, highlighting both the total outstanding amounts and growth percentages for each
category. It enables users to evaluate lending trends across segments such as personal,
business, and auto loans, as well as credit card usage in retail and business domains.
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The charts display the total outstanding loan balances across all types of loans and their
corresponding growth percentages. It provides an overall view of the organization's lending

portfolio and its growth trends over time.

Figure 8-22 Loans Growth Report
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8.1.2.5.1.1.2.2 KPI Glossary
All KPIs come with KPI Glossary that details below:

* KPI Name
» Description
e Calculation logic

* Logical Interpretation

KPI Glossary is made available by right clicking on any of the KPI visualizations as shown

below:

Figure 8-23 KPI Glossary

CASA Rata Tostal Liovaivs wa Dy

W A Tarriits

2 i e« LA,

e and Bensrveed Credn

Lhak b Pt
Frrsl Quarier Parcsd hisve sl ieacamiics.

Coontinnal Freminag

I

ORACLE"

8-15



Chapter 8
Data Browser

Figure 8-24 KPI Glossary Report

8.1.2.5.1.1.2.3 Drill through for KPIs
Drill-down functionality enables user to view KPI data at the lowest granularity.

User starts pre-built report visualization from results (fact entities based) -> drill down to
more granular results (multiple levels of drill down in fact entities) -> View data at lowest
granularity.

Example:

Time Series report -> Education Loans KPI -> Country name drill down -> Party type (or party
name) drill down -> Account skey in fact common account summary -> Stage Loan Contracts

Figure 8-25 Drill through for KPIs

Qutstanding Leans

0 0

Hover over education loans as shown below to look at overall numbers:
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Figure 8-26 Balance Sheet KPIs

Education Loans Issued

Q42020-20.
Q22021-20.
Q42021-20.
Q22022-20.
0Q42022-20,

Figure 8-27 Drill

Total Outstanding Loans 305,282,858.62

Balance Sheet Product Type Description Education Loans Issued

Fiscal Quarter Period Name Q42022-2022

I 1

Right click and select Country name from drill down option as below:

Q42020-20.
Q22021-20.

Drill

‘ducation Loans Issued|  Drill to a data element

Q22021-20.
042021-20.
Q22022-20.
042022-20.

Hierarchies

A

2 D > I I D Is

Q42021-20.
Q22022-20.
Q42022-20.
0Q42020-20.
Q22021-20.
Q42021-20...
Q22022-20...
Q42022-20...
Q42020-20...
Q22021-20...

Data Elements

il

Country Numeric Identifier
Country Risk Factor
Country Surrogate Key
Advanced Economy Flag
Country Description
Country Code

Co Country Name ption

Country Name

st s Memmime © e
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Figure 8-28 Drilldown at Country

Qutstanding Loans

Figure 8-29 Drill down to Party Name

Drill
Drill to a data element

Hierarchies Data Elements

Parent Party Group Code B
A Party Parent Group Name
A Party Parent ldentifier
A Partner Code
A Party Full Name
A Party Identifier
A pPa Party Name ame
A Party Name o

Figure 8-30 Party Name Drill down
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Figure 8-31 Drill down for account level

Drill

Drill to a data element

Hieranchie: Data Elements

-
Account Description
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b Account Or Contract Number
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Figure 8-32 Account drilldown
Cutstanding Loans

1484

1084

8.1.2.5.1.2 Time Series

This report gives a view into trend analysis of total outstanding loans, deposits and
investments over multiple time periods and how they have changed over time. It gives
breakdown of deposit types accepted and loan types floated in the market. It also shows
snapshot of Debt and Equity Investments over multiple time periods. Users have options to
choose values for pre-configured filter attributes or add their own filters.
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Figure 8-33 Time Series
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8.1.2.5.1.3 Deposit Growth

The Deposit Growth Visualization provides an insightful analysis of a financial institution's
deposit portfolio, focusing on key deposit categories of Current or check-in Account and
Savings Accounts and their movement over time periods. By offering detailed insights into
CASA ratio, total deposits, CASA deposits, and term deposits, users can effectively track and
analyze growth trends across different deposit categories.

Figure 8-34 Deposit Growth

8.1.2.5.1.4 Loans Growth

The Loans Growth Report offers a detailed analysis of loan, credit cards and overdraft
performance, highlighting both the total outstanding amounts and growth percentages for each
category. It enables users to evaluate lending trends across segments such as personal,
business, and auto loans, as well as credit card usage in retail and business domains.
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The charts display the total outstanding loan balances across all types of loans and their
corresponding growth percentages. It provides an overall view of the organization's lending
portfolio and its growth trends over time.

Figure 8-35 Loans Growth Report
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8.1.2.5.1.5 KPI Glossary

All KPIs come with KPI Glossary that details below:
¢ KPI Name

* Description

e Calculation logic

* Logical Interpretation

KPI Glossary is made available by right clicking on any of the KPI visualizations as shown
below:

Figure 8-36 KPI Glossary

CASA Rty Tostsl Loswfrs wa Dy

8 Moy I+ CACTA

e and Bensrvend Credn

bk i Pt
Farsl Qusrisr Pavad e 2cke B atiaes

Comndanaal Fremaning

Crdor

ORACLE"

8-21



Chapter 8
Data Browser

Figure 8-37 KPI Glossary Report

8.1.2.5.1.6 Drill through for KPIs

Drill-down functionality enables user to view KPI data at the lowest granularity.

User starts pre-built report visualization from results (fact entities based) -> drill down to
more granular results (multiple levels of drill down in fact entities) -> View data at lowest
granularity.

Example:

Time Series report -> Education Loans KPI -> Country name drill down -> Party type (or party
name) drill down -> Account skey in fact common account summary -> Stage Loan Contracts

Figure 8-38 Dirill through for KPIs

Qutstanding Loars

0 0

Hover over education loans as shown below to look at overall numbers:
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Figure 8-39 Balance Sheet KPIs

Education Loans Issued

Q42020-20.
Q22021-20.
Q42021-20.
Q22022-20.
0Q42022-20,

Figure 8-40 Dirill

Total Outstanding Loans 305,282,858.62

Balance Sheet Product Type Description Education Loans Issued

Fiscal Quarter Period Name Q42022-2022

I 1

Right click and select Country name from drill down option as below:

Q42020-20.
Q22021-20.

Drill

‘ducation Loans Issued|  Drill to a data element

Q22021-20.
042021-20.
Q22022-20.
042022-20.

Hierarchies

A
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Q42021-20.
Q22022-20.
Q42022-20.
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Q22021-20.
Q42021-20...
Q22022-20...
Q42022-20...
Q42020-20...
Q22021-20...

Data Elements
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Country Numeric Identifier
Country Risk Factor
Country Surrogate Key
Advanced Economy Flag
Country Description
Country Code

Co Country Name ption

Country Name
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Figure 8-41 Drilldown at Country

Qutstanding Loans

Figure 8-42 Drill down to Party Name

Drill
Drill to a data element

Hierarchies Data Elements
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Figure 8-43 Party Name Drill down
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Figure 8-44 Drill down for account level
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Figure 8-45 Account drilldown

Cutstanding Loans

8.1.3 Pre-Built Reports

Most of the subject areas have a corresponding pre-built report for results data visualization.
Pre-Built reports have pre-configured tabular data and data visualization dashboards from the
entities within the subject area. You can view data for the pre-configured set of attributes in
these dashboards. You will have Read-only access to these reports as they are configured out-

of-the-box.

To access these reports, navigate through the following path:

1. Home - Catalog - Shared Folders — Data Foundation Reports.

ORACLE"
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Figure 8-46 Catalog Shared Folders

- = Catalo Create =
Analytics g em o
My Folders Shared Folders Search Q Sort By Meodified B =
Home
Type Name Description Owner Modified v
[ catalog
. ) [} Data Quality Visualization Visualization for Data Quality Checks notavaila... 8 Feb2025
9 Machine Learning
[} Data Governance Data Governance dashboards for DG us...  not availa 2 Jan 2025
[} Recenciliation Framework Reconciliation Framework System A 17 Sep 2024
D Data Foundation Custom Reports Data Foundatidn Custom Visualizations not availa. 30 Jul 2024
D Data Foundation Reports Data Foundation In-Built Reports not availa... 23 Jul 2024

Use Case Report: The use case reports serve as a download specification, helping you
identify the stage entities required for loading data into a specific Oracle Financial
Services application. Customers using multiple Oracle applications often need insights
into data reusability—determining whether data loaded for one application can be
leveraged for another. By providing this clarity, the specification enhances integration
efficiency, optimizes data management, and streamlines operations across Oracle’s
financial ecosystem.

a. Click Data Foundation Reports the list of reports is displayed.

Figure 8-47 Catalog Shared Folders Sample Reports

My Folders  Shared Folders Search Q SortBy  Modified v =
Shared Folders > Data Foundation Reports

Type Name Description Owner Modified

D Source Data Source Data Visualization not availa... 5 Sep 2024

D Use Case Analysis Use Case Analysis Report not availa... 26 Jul 2024

D Sample Reports Sample Reports for Subject Areas notavaila... 23 Jul 2024

D Right To Forget Right To Forget Reports not availa... 23 Jul 2024

D Reports Glossary Glossary for Subject Areas, KPI, etc. not availa... 23 Jul 2024

D Key Performance Indicators Reports on Key Performance Indicators not availa... 23 Jul 2024

D External Glossary - BIRD External Glossary (BIRD Reports) notavaila... 23 Jul 2024

b. Click Sample Reports from the list.

The Right to Forget use case defines the process for identifying and deleting personal
data from Oracle Financial Services applications while ensuring compliance with privacy
regulations. It helps users manage data removal with minimal system impact, offering
clarity on data dependencies and compliance across multiple Oracle applications.

a. Click Data Foundation Reports the list of reports is displayed.
b. Click Right To Forget from the list.

c. Select Data Anonymization to view the reports. For more information, see Right To
Forget.

ORACLE 896



Chapter 8
Data Browser

Figure 8-48 Right to Forget Reports

My Folders  Shared Folders Search Q SortBy  Modified v B E

Shared Folders > Data Foundation Reports > Right To Forget

Type Name Description Owner Modified v
-3
@ Sensitive Data Anonymization not availa... 23 Jul 2024

8.1.3.1 Navigation Path

To access these reports, navigate through the following path:

1
2
3.
4

Navigate to the Data Foundation for Banking Home page > Data Visualisation.

Under the Data Visualisation section, click View Pre-built Reports.

From the Shared Folder window, select Data Foundation Reports type.

From the Data Foundation Reports menu, select Pre-built Reports.

The following list of types are displayed.

Transaction Summary

Mitigants Summary

Placed Collateral Summary
Accounts — Derivatives Summary
Customer Account Summary
Party Summary

GL Summary

Credit Line Summary

8.1.3.2 Transaction Summary

These pre-built interactive reports, based on the Transactions subject area, provide detailed
insights into bank inflows and outflows. The reports support informed decision-making across
liquidity management, customer behavior analysis, and operational strategy.

Top 10 Inflow - Outflow Transactions

Purpose: Offers a quick snapshot of the top 10 highest-value inflow or outflow transactions
during a selected period.

ORACLE
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Inflow Outflow Amount Indicator: All

REP_TXN_BILCTR_125356
REP_TXN_CORTR_100621
REP_TXN_FUTTR_58964
REP_TXN_INVTR_48250
REP_TXN_LEATR_1683
REP_TXN_LONTR_103969
REP_TXN_OPCNTR_75425

REP_TXN_SWACTR_78549

Transaction Reference Number

Top 10 Inflow- Outflow Transactions

Transaction Channel Type: All - Transaction Reference Number: All - Party Name: All

09/30/2024
12/31/2024
10/31/2024
11/30/2024
11/30/2024
11/30/2024
12/31/2024
09/30/2024

Top 10 Parties For Each Transactions Type

Transaction Date  Product Name  Transaction Channel Type  Party Name

7B Cheque

SA ATM Deposit
INSCLAIM Debit Card Swipe
1BTB Online Transaction
CA OTH

STULOAN OTH

0BS ATM Deposit

oD Debit Card Swipe

Top 10 Party Names by Transaction Type:1- 10 Transaction Type Description: All  Branch Name: All

Transaction Type Description: All - Product Name: All - Top 10 Transactions: 1 - 10

Transaction Type Description
Securities Sold Transaction Amount
Securities Purchased Transaction Cost
Insurance Claim

Interbank transfer

CASA Deposits withdrawn

Loan disbursement

Securities Purchased Transaction Cost

Charges and Fees Receipt

Transaction Type Description PartyName  Transaction Amount In Reporting Currency

CASA Deposits Accepted
CASA Deposits withdrawn

Card Repayment

7,569,336,111.00
7,569,940,197.00

7,569,667,677.00

Transaction Amount In Reporting Currency
7,569,992,430.00
7,569,997,729.00
7,569,986,574.00
7,569,991,673.00
7,569,990,159.00
7,569,986,574.00
7,569,992,430.00

7,569,987,888.00

« Features:

— Interactive filters for selecting inflows or outflows.

— Useful for tracking major deposit sources or significant fund disbursements.

* Insights Provided:

— Liquidity trends

— High-value transaction impact

— Customer behavior

Inflow — Outflow Transactions Above Threshold --> Inflow - Outflow Transactions Above
Chosen Threshold

Purpose: Focuses on transactions exceeding a user-defined monetary threshold.

Figure 8-50 Transactions Above Chosen Threshold

Transaction Amount: > 10,000

@ Inflow-Outflow Transactions Above Chosen Threshold

Inflow Outflow Amount Indicator: All - Branch Name: All

Transaction Reference Number Transaction Date Party Name Product Name Transaction Amount In Reporting Currency

REP_TXN_BILCTR_1 01/30/2024
REP_TXN_BILCTR_10 01/30/2024
REP_TXN_BILCTR_100 01/30/2024
REP_TXN_BILCTR_1000 07/31/2024
REP_TXN_BILCTR_10000 08/31/2023
REP_TXN_BILCTR_100000 08/31/2023
REP_TXN_BILCTR_100001 08/31/2023
REP_TXN_BILCTR_100002 08/31/2023
REP_TXN_BILCTR_100003 08/31/2023
REP_TXN_BILCTR_100004 08/31/2023
REP_TXN_BILCTR_100005 08/31/2023
REP_TXN_BILCTR_100006 08/31/2023
REP_TXN_BILCTR_100007 08/31/2023
REP_TXN_BILCTR_100008 08/31/2023
REP_TXN_BILCTR_100009 08/31/2023

CA

CA

CA

CA

cC

SA

SA

SA

SA

SA

SA

SA

SA

SA

SA

1,710,335,520.00
2,916,342,500.00
2,626,166,989.00
1,095,073,929.00
3,761,090,155.00
1,971,381,671.00
4,122,209,435.00
3,346,832,503.00
5,983,203,095.00
2,410,553,707.00
6,621,167,873.00
5,031,021,571.00
3,344,352,571.00
3,739,297,639.00

5,940,033,656.00
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* Features:
— Dynamic filters and sorting options
—  Supports filtering by inflow or outflow
* Insights Provided:
— Identification of high-value activities
— Risk and liquidity monitoring

— Strategic cash management

Parties by Transaction Type

Purpose: Shows the top 10 parties based on transaction volumes for each transaction type.

Figure 8-51 Parties by Transaction Type

Top 10 Parties For Each Transactions Type

Top 10 Party Names by Transaction Type: 1 - 10 Transaction Type Description: All  Branch Name: All

Transaction Type Description Party Name Transaction Amount In Reporting Currency
CASA Deposits Accepted 7,569,336,111.00
CASA Deposits withdrawn 7,569,940,197.00
Card Repayment 7,569,667,677.00
Card Usage 7,568,847,089.00
Charges and Fees Receipt 7,569,887,207.00
Insurance Claim 7,569,159,730.00
Interbank transfer 7,569,155,945.00
Loan disbursement 7,569,746,405.00

* Features:
— Tabular visualization
— Segregated by transaction category
e Insights Provided:
— Identification of key customers or business partners
— Behavioral patterns by transaction type

Legal Entity Transaction Totals by Region & Branch -->Total Inflow- Outflow
Transactions of Legal Entity by Region and Branch

Purpose: Displays geographic transaction trends using heat maps.
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Issuer Region Code Branch Name

02ZYLyl
07sRRnZ
09RAKTa uRUYggK
OBIilSL Wv8fimo
OK2kDPk
OL5Y6R3 kBRVpBY

Total Inflow-Outflow Transactions Of Legal Entity By Region And Branch

Transaction Type Description

Others
Others
Others
Others
Others

Others

Issuer Region Code: All  Branch Name:All - Transaction Type Description: All  Inflow Outflow Amount Indicator: All

Transaction Amount In Reporting Currency

431,490.00
232,399.00
273,277.00
505,676.00
376,986.00

482,209.00

Number Of Transactions

BB R R R R

e Features:

— Regional and branch-level breakdown

— Visual heat intensity based on transaction volume

* Insights Provided:

— Hotspots of activity

— Fraud detection opportunities

— Regional growth and service optimization

Regional Analysis by Transaction Type

Purpose: Displays how transaction types are distributed across different regions.

Figure 8-53 Regional Analysis by Transaction Type

Regional Analysis By Transaction Type

100%

Transaction Amount In Reporting Currency

Issuer Region Code: All - Transaction Type Description: All  Inflow Outflow Amount Indicator: All

Transaction Type Desc...

B CASA Deposits Acc...
CASA Deposits wit...

W Card Repayment
Card Usage

M Charges and FeesR...
Insurance Claim

M Interbank transfer
Loan disbursement
Loan repayment
Missing

M 0D disbursement
0D repayment

0BIiISL 77ToRUE AaN9BPY

REGION_1

REGION_2

Issuer Region Code

REGION_3

hkzValt

W Others

« Features:
— Stacked bar charts

* Insights Provided:

— Popular transaction types by geography

— Regional customer preferences

Branch-Wise Analysis Within a Region

Purpose: Compares branch performance within a selected region.
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Figure 8-54 Branch-Wise Analysis Within a Region

Branch Wise Analysis Of Specific Region

Inflow Outflow Amount Indicator: All  Issuer Region Code: All - Transaction Type Description: All - Branch Name: All

L. Leooor Transaction Type Desc

2 B CASA Deposits Acc...

R CASA Deposits wit...

2 I I I W Card Repayment

5§ L2000m Card Usage

g B Charges and Fees R

= 900.0T Insurance Claim

5 ] L] ] M Interbank transfer

E 600.0T Loan disbursement

g Loan repayment

g M 0D disbursement

= 00 0D repayment.
BRANCH1 BRANCH2 BRANCH3 Missing PRPLSpt W8fim9 B Others

* Features:

— Transaction volume visualization per branch
* Insights Provided

—  Performance benchmarking

— Localized strategic planning

Transaction Type Distribution

Purpose: Offers a complete view of how funds move across different transaction types.

Figure 8-55 Transaction Type Distribution

Transaction Type Distribution
Inflow Outflow Amount Indicator: All  Transaction Type Description: All Issuer Region Code: All  Branch Name: All
1,200.0T Inflow Outflow Amoun. .
< 1,000.0T 961.2T 958.5T 959.2T 959.8T mo
€2 1
28 80007 .2
3
= 600.0T 541.5T 3
2 479.8T 480.0T 479.7T 480.5T 479.27 M
g3 40007 ms
58 240.7T 239.7T 240.7T 240.3T 239.5T 240.3T 239.9T 238.8T 239.8T 240.2T o
i - . . . . . . . . . .
7
00 8
388 33EL 95 v§ 5L 0 S22 3g 3¢ ] & £ £ £3 238 @858
58 “82 g 2 £2é 3 g g 3 > s 3 > o S8 g8 82 WA
8% &= g Us z £5 k] 2 ] 2 % ©55 85 ag =
< s & £ = 5 13 35 g s 8
Transaction Type Description

* Features:

— Color-coded for inflow vs. outflow
* Insights Provided:

— Most frequent transaction activities

— Balanced view of cash flow behavior

Regional Inflow Analysis

Purpose: Shows percentage contribution of each region to total inflows.
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Figure 8-56 Regional Inflow Analysis

Inflow - Transaction Analysis On Regional Basis Outflow - Transaction Analysis On Regional Basis
5,0(1;2 5.8;//: 0% Issuer Region Code
0% W 0BILilISL
W 1Eh4CMK
Issuer Region Code 5tLsosv
3131% i 31.37% 77ToRUE
31.41% 2&2:2:1 5136% . :;ag:::g
REGION_3 PKoabme
Region2 REGION_1
31.37% 31.4% zégjg:é
RegwonZ’
 Features:
— Filters for specific transaction types
* Insights Provided:
— Regional deposit trends
— Customer deposit behavior
Regional Outflow Analysis
Purpose: Displays regional contributions to total outflows.
¢ Features:
— Filters by transaction types
* Insights Provided:
— Regional spending trends
— Liquidity risk identification
Branch-Wise Inflow Analysis
Purpose: Breaks down inflow activity at the branch level.
Figure 8-57 Regional Inflow Analysis
Transaction Analysis by Branch Wise - Inflow Transaction Analysis by Branch Wise - Outflow
Issuer Region Code: All  Branch Name: All Issuer Region Code: All  Branch Name: All
0% 0% 0%
33.34% 33.37% 33.36% 33.36%
33.27% 33.27%
Branch Name 7zVBnsZ BRANCH1 BRANCH2 BRANCH3 Gb7QRGQ Missing Branch Name BRANCH1 BRANCH2 BRANCH3 Missing PRPLSpt M Wv8fim9

 Features:

— Filter by transaction types

e Insights Provided:

— Top deposit-generating branches
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— Targeted deposit strategies

Branch-Wise Outflow Analysis

Purpose: Details outflow trends across branches.

* Features:

— Filter by transaction types
* Insights Provided:

— Lending/spending behavior

— Branch-level financial insights

Forecast of Future Transactions

Purpose: Predicts future transactions using historical data for the next quarter.

e Features:

— Filters by date, region, branch, transaction type

* Insights Provided:
— Trend analysis

— Forward-looking strategic planning

8.1.3.3 Mitigants Summary

ORACLE
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This pre-built report, based on the Mitigants subject area, offers a comprehensive view of
risk reduction strategies implemented across products, branches, and regions. It aids in
evaluating the effectiveness of various mitigants, identifying exposure gaps, and enhancing

risk management practices.

Mitigant Summary

A mitigant summary table displays various mitigating factors or actions designed to reduce risk
or exposure. In financial contexts, this could refer to strategies or assets that reduce the risk

associated with liabilities, investments, or other financial obligations.
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Figure 8-58 Mitigant Summary
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Mitigant Summary
Mitigant Description: All - Mitigant Type Description: All
Account Description Mitigant Description Mitigant Type Description Exposure Covered Amount
LC_ACC8711 MC009 corpbond 747,315.00
LC_ACC8711 MC014 pldcsh 27,760.60
LC_ACC8714 MC002 mie 140,381.70
LC_ACC8715 MC002 mie 374,351.20
LC_ACC8715 UNCOV uncov 0.00
LC_ACC8727 MC007 bnds 557,857.60
LC_ACC8727 MC008 coll-guar 153,380.00
LC_ACC8731 MC009 corpbond 498,210.00
LC_ACC8731 MC014 pldesh 124,922.70
LC_ACC8736 MC003 pldlip 58,535.40
LC_ACC8736 UNCOV uncov 0.00
LC_ACC8743 MC007 bnds 627,589.80
LC_ACC8743 MC008 coll-guar 19,172.50
LC_ACC8755 MC003 pldlip 117,070.80
LC_ACC8755 UNCOV uncov 0.00
Types of Mitigants Received
Purpose: Tracks the usage and value of different risk mitigants over time.
Figure 8-59 Types of Mitigants Received
Types of Mitigants Received
Year Of The Calendar Date: All Mitigant Type: All
oM
5M
% aM
% M Year Of The Calendar
E oM | I | I W 2025
. s b b bbbl e bl
= T g :r o3 - ¢

1TigvMI
HOUZzoiV
HiLvXIC
KxjPGWe
Others
QevrsbF
bnds
coll-guar
corpbo.

Mitigant Type Description

mie

nettliab

pldcsh

pldlip

8

@

t-bill
uncov

Insights Provided:
e Trends in mitigant effectiveness
e Shifts in risk exposure

e Performance benchmarking of mitigant types

Specific Product Risk Coverage — Trend Analysis

Purpose: Tracks historical trends in risk coverage across individual product types.
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Figure 8-60 Specific Product Risk Coverage — Trend Analysis

Specific Product Risk Coverage Trend Analysis
Product Type Description: All
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g 108 10T 5
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2025 2027
Calendar Date

Insights Provided:

e Visibility into changes in product-level exposure

e Evaluation of mitigant impact over time

e Strategic input for improving product-specific risk handling
Covered vs. Uncovered Amounts by Branch

Purpose: Shows covered and uncovered risk values across branches as of a given date.

Figure 8-61 Covered vs. Uncovered Amounts by Branch

Covered vs. Uncovered Amounts by Branch

Branch Name: Al Product Type Description: All
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Branch Name

Insights Provided:
*  Branch-level exposure visibility
- Effectiveness of mitigants at individual locations

« ldentification of high-risk branches for further action

Product-wise Risk Coverage Across Branches

Purpose: Combines product and branch views to assess risk coverage at a granular level.
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Figure 8-62 Product-wise Risk Coverage Across Branches

Product Wise Risk Coverage Across Branches

Product Type Description: All - Region Description: All - Branch Name: All
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Product Type Description, Branch Name

Insights Provided:

* Detailed branch-level performance by product type
» Coverage adequacy and gaps

» Data to support localized mitigation strategies
Regional Product Distribution Dashboard

Purpose: Offers a snapshot of how products are distributed across regions.

Figure 8-63 Regional Product Distribution Dashboard

Regional Product Distribution Dashboard
Product Type Description: All Region Description: All

Product Type Descript

B CY78TJz, Exposure...
CY78TJz, Uncovere...

W FOK8Q62, Exposur.
FOK8Q62, Uncover
1B0dk37, Exposure ..
1B0dK37, Uncovere...

Small Consumer Cr...
B Small Consumer Cr...

0 msKQNKG, Exposur...
2RuvYgh EP9qLIl Region1 Region2 Region3 ykL2heA msKQNKG, Uncover...

Region Description

Insights Provided:
e Product demand by geography
* Regional risk profiles

* Market segmentation and strategic planning inputs

8.1.3.4 Placed Collateral Summary

This pre-built report, based on the Placed Collateral subject area, provides a
comprehensive overview of collateral posted against derivative exposures. It includes details
about the type, value, and distribution of collateral across counterparties, enabling effective
counterparty risk monitoring and collateral management.

Product Risk Coverage Analysis

Purpose: Assesses the extent of mitigant coverage across various product types.
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Figure 8-64 Product Risk Coverage Analysis

@ Products against which collateral placed

Product Type Description: Al
18M

15M

12M

Collateral Market Value
©
<

Account
Information
Loans

Loan

Loan

Service Provider
Secured

Agricultural
Business Loan
Demand Deposit
Education Loans
General Loans
Home Equity
Line of Credit
Home Equity
Margin Lending
Mortgage Loans
Mortgage
Refinance Loan
Personal Loans
Borrowing
Small Consumer
Credit Loans

Product Type Description

M End Of Period Balance M Collateral Market Value

Vehicle Loans.

59,165.00

End Of Period Balance

Insights Provided:

» ldentification of uncovered exposures

» Effectiveness of applied mitigants

e Strategic input for risk-based resource allocation
Branch Collateral Coverage Analysis

Purpose: Analyzes how collateral is distributed across different branches.

Figure 8-65 Branch Collateral Coverage Analysis

Branchwise comparision of Collateral Market Value

Branch Name: All  Region Description: All
70M

50M

40M

30M

Collateral Market Value

10M

BRANCH1 BRANCH2 BRANCH3

Insights Provided:
* Detection of under-collateralized or high-risk branches
e Valuation trends and anomalies

* Inputs for targeted audit planning and risk control

ORACLE
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Branch Product Coverage Dashboard

Purpose: Displays product-wise collateral coverage at the branch level.

Figure 8-66 Branch Product Coverage Dashboard

@ Branch Product Coverage Dashboard

Region Description: All  Product Type Description: All - Branch Name: All
10M

8M

M

M I
o

Collateral Market Value
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Branch Name

Product Type Descripti

M Account Informatio
Agricultural Loans

W Business Loan
Demand Deposit L...

M Education Loans
General Loans

W Home Equity Line o...
Home Equity Loan
Margin Lending
Mortgage Loans

M Mortgage Refinanc...
Others

M Personal Loans
Secured Borrowing

W Small Consumer Cr...
Vehicle Loans

Insights Provided:
* Performance analysis of individual branches
e Product popularity and coverage efficiency

« Data to support product-specific strategies and investments

Branch-wise EOP Balance vs. Collateral Market Value

Purpose: Compares End-of-Period (EOP) loan balances to collateral market values at

each branch.

Figure 8-67 Branch-wise EOP Balance vs. Collateral Market Value

Branchwise EOP Balance vs. Collateral Market Value

Branch Name: All - Region Description: Al

End Of Period Balance

50M

40M

30M

Collateral Market Value

20M

BRANCH1 BRANCH2 BRANCH3
Branch Name

Insights Provided:

« Detection of over-leveraged branches

ORACLE"
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e Adequacy of collateral coverage

« Performance benchmarking across the branch network

Types of Collateral Received

Purpose: Tracks usage and value of different collateral types over time.

Figure 8-68 Types of collateral placed

@ Types of collateral placed

Mitigant Type Description:All - Year Of The Calendar Date: All
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40M
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- . I l I . l
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....... ralized Loan Mortgage-Backed Commercial Real Estate Mortgage-Backed Securities  Other Real Estate-Related Collateral  Private Lb\M ortgage-ad cked
Securif ities

=
5]
4

Mitigant Type Des:

Insights Provided:
e Trends in collateral preference and effectiveness
« Changes in exposure and coverage adequacy

* Improved strategy development for managing counterparty and liquidity risk

8.1.3.5 Accounts — Derivatives Summary

ORACLE

This pre-built report, based on the Accounts subject area, delivers a high-level snapshot of
an institution’s derivative exposure and performance as of a specific date. It offers valuable
insights into notional values, market positions, and counterparty risk, enabling
stakeholders to monitor risk, performance, and portfolio health effectively.

Account Dimension Derivatives

This table is primarily used for understanding the exposure, fair value, and position of different
derivative instruments.
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Figure 8-69 Account Derivatives - canvas 1
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Derivative Performance Tracker

This shows a Derivative Performance Tracker visualized as a bar chart. It compares different
derivative product types based on their notional amounts as date.

Figure 8-70 Derivative Performance Tracker

© Derivative Performance Tracker by Product Type
Product Type Description: Forwards, Futures,
18

Options, Swap

108

Contracts.. +2

Derivative Performance Tracker

Purpose: Tracks overall derivative exposure and performance trends over time.

ORACLE
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Figure 8-71 Derivative Performance Tracker by Instrument Type

Derivative Performance Tracker by Instrument Type
Product Type Description: All  Risk Factor Type Description: All
4008
3508
3008
£ 2508
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Insights Provided:

* Identifies high-performing and underperforming derivatives

*  Supports strategic decisions by visualizing product growth patterns
* Helps manage risk associated with volatility or declining instruments
Derivative Allocation Overview

Purpose: Displays portfolio distribution by derivative type.

Figure 8-72 Derivative Allocation Overview

Derivative Allocation Overview

Product Type Description: All
fxs 1.26%
Swap Contracts 1.19%
Options 1.08%

Forwards 1.07%
Futures 1.23%

Product Type Descripti..

W Forvards
W Futures
W Missing
Options
W Repurchase Agree...
M Swap Contracts
W fxs

Insights Provided:
e Visual assessment of asset allocation
e Highlights concentration risks

e Supports diversification efforts and client transparency

OTC vs. Exchange-Traded Derivatives Breakdown

Purpose: Compares notional exposure between OTC and exchange-traded contracts.

ORACLE"
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Figure 8-73 OTC vs Exchange Traded Derivatives Breakdown

OTC vs Exchange Traded Derivatives Breakdown
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Insights Provided:
* Highlights potential credit and counterparty risks
* Informs regulatory compliance and transparency levels

e Aids in assessing market structure and risk mitigation needs

Instrument Type Distribution

Purpose: Compares notional exposure between OTC and exchange-traded contracts.

Figure 8-74 Instrument Type Distribution

Instrument Type Distribution
Risk Factor Type Description: All

0% Commodity 4%
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Index 0% u
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Insights Provided:
» Evaluates exposure across various instruments (e.g., swaps, options, forwards)
» Detects over-concentration and potential risk hotspots

» Enables proactive rebalancing and enhanced risk control

8.1.3.6 Customer Account Summary

This pre-built report is based on Accounts subject area. It provides stakeholders with an overall
summary of credit status of institution's assets such as loans as of the selected date.
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Credit Status: This provides a view of end-of-period balance in the reporting currency by
credit status across regions and branches. It enables stakeholders to assess the health of
credit portfolios and identify areas requiring attention. This helps in monitoring regional and
branch-level credit performance and risk exposure and helps identifying if any specific region
or branch needs attention.

Figure 8-75 Credit Status

= Year Of The Calendar Date “ Month Period Name = Calendar Date

Non Performing Assets: Provides a visual representation of non performing assets (NPAS),
where definition of non performing asset is as per jurisdictional regulator and user provides
data marking accounts as NPA. This visualization is based on across regions using bar charts.
It offers insights into the distribution and health of non-performing assets (NPAS) by region.

Figure 8-76 Non Performing Assets
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Branchwise NPA - This displays the distribution of non-performing assets (NPAs) across
branches for a particular region, segmented into various credit status categories such as
Bankrupt, Impaired, Written Off, and Delinquent. This chart provides a view of NPA
composition for each branch, enabling stakeholders to quickly assess and compare the extent
and type of financial risk across different branches of a given region. This is especially helpful if
user sees unexpected data for a given region in previous visualization, and wants to view data
spread across branches for that region.
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Figure 8-77 Branchwise NPA
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8.1.3.7 Party Summary

ORACLE

This pre-built report is based on party subject area. It provides stakeholders with an overall
summary of parties to which bank has exposure. It gives view into parties and their related
parties, along with the financial exposure numbers like total assets vs liabilities outstanding
against all parties. It also gives view into parties’ risk profile analysis based on their credit
rating.

Risk Profile Analysis: This visualization illustrates the risk profile of parties to which the
bank has credit exposure, based on their credit ratings as of the selected date. The bar
chart displays credit ratings along with the corresponding number of parties for each rating.
Users can filter the data based on Domestic vs. Foreign ratings and Rating Source
Code (Rating Agency) using the filter options provided at the top of the visualization.
Each rating source code is shown alongside the count of party identifiers, offering a clear
view of the risk rating distribution.

This visualization helps assess the overall risk landscape of institutional assets, such as
loans, enabling informed decision-making and effective risk management strategies.

The dashboard includes several default filters, such as Calendar Date, Purpose
Description for Domestic/Foreign Currency Ratings, and Rating Source Description,
allowing users to tailor their view based on specific preferences or requirements.

— Objective: To highlight the number of parties for each credit rating by a specific Credit
Agency and rating purpose.
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Figure 8-78 Risk Profile Analysis
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< Party Financial Details: The visualization displays the total assets and liabilities of the
parties for the financial period as per selected Calendar date. Each party is listed with its
corresponding asset and liability amount, highlighting their financial position/obligation for
the selected calendar date. This analysis provides insights into the key contributors to the
organization's asset/liability base, aiding in performance assessment. This analysis also
facilitates insights into risk assessment and financial planning. User also has the option to
select specific party name from filter attribute on top and get view for a specific party.

— Objective — To highlight total amount of asset and liabilities against all parties or
specific party as of specific date

Figure 8-79 Party Financial Details

k= Party Financials

s# Calendar Date Party |dentifier

A

Party Financial Details

Party Identifier Total Assets Total Liabilities Financial Year Start Financial Year End

PARTY 1 2,30,59,404.00 1,04,69.422.82 01/04/2020 12:00:00 AM 31/03/2021 12:00:00 AM
PARTY_1 1,92,85,171.00 B84,33,086.87 01/04/2021 12:00:00 AM 31/05/2022 12:00:00 AM
PARTY_1 83,29,595.00 40,70,682.55 01/04/2022 12:00:00 AM 317032023 12:00:00 AM
PARTY_10 2,50,91,283.00 1,02,81717.75 01,/04/2020 12:00:00 AM 31/03/2021 12:00:00 AM
PARTY_10 1,95,10,358.00 B7,05572.83 01/04/2021 12:00:00 AM 31/03/2022 12:00:00 AM
PARTY_10 8299,529.00 36,85,228.67 01/04/2022 12:00:00 AM 31,/03/2023 12:00:00 AM

— Party Party Relationships and Party Party Account Relationship: Party relationship
visualizations provides a view of party relationships and their associated accounts
details. Relationship between related party and primary party could be personal like
spouse, parent, etc. of primary account holder or professional like CEO, Director of an
organization that is bank’s customer.

e Party Party Relationships:

— Objective — To highlight the relationship between different parties and relationship
effective date.
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Figure 8-80 Party Party Relationships

k% Party Party Relationships
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PARTY_1 Affiliate PARTY_3 170572020

PARTY_1 Chief Accountant PARTY_10 26/02/2020 12:00:00 AM
PARTY_1 Chief Accountant PARTY_S 03/04/2022 12:00:00 AM
PARTY_1 Chief Executive PARTY_ & 01/11/2019 12:00:00 AM
PARTY_1 Chief Executive PARTY_7 06/03 /2021 12:00:00 AM
PARTY_1 Director PARTY_% 21/10/2022 12:00:00 AM
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e Party Party Account Relationship:

— Objective — The dashboard gives view of party relationships and their associated
accounts.

Figure 8-81 Party Party Account Relationship

-~ k£ Party Party Account Relationships

= Calendar Date Party ldentifier

Party Party Account Relationship

B b Relationship Related Party Cwnership Account Related Account
s Typa Description identifier Description Description
PARTY_10 Affiliate PARTY_2 Account 501 Account 291
PARTY_10 Affitiate PARTY_2 Account 305 Account 295
PARTY_10 Atfiliate PARTY_2 Ateount 306 Accsunt 296

8.1.3.8 GL Summary

ORACLE

Financial Ledger pre-built report is based on subject area by the same name. It provides
stakeholders with an overall summary of institutions’ Chart of Accounts (CoA) as of the
selected date.

General Ledger Analysis and GL Account Distribution

The first two dashboards feature a series of donut visualizations that display the 5 main CoA
categories such as Assets, Expenses, Liabilities, Owner’s Equity, and Revenue. Each CoA
category has separate donut view for every currency where bank has exposure. The donut
shows breakdown for the CoA by the types of General Ledger (GL) data for each currency.

For example: For CoA of Assets, banks may have data spread across various currencies.
Donut will show view for Assets spread across their natural currencies by various GL types
(means asset types here) like Cash, Inventory, Fixed Assets, and so on.

The graph displays a General Ledger (GL) Account Distribution Overview in a visual
format, with data organized by different currencies and financial categories. Each row
corresponds to a specific currency (Bangladesh Taka, Euro, Indian Rupee, Kazakhstan Tenge),
and within each column, the financial distribution is shown across key categories: Asset,
Expense, Liability, Owners Equity, and Revenue.
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Figure 8-82 GL Reconciliation
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General Ledger Analysis  GL Account Distribution  Actual vs. Budget us. For

First dashboard shows the data in local currency, whereas second dashboard shows data in
common accounting currency. Third dashboard shows data spread across various GL
Accounts for Budgeted Vs Actual Vs Forecasted numbers.

Figure 8-83 General Ledger Analysis
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Actual vs Budget vs Forecast

The Actual vs. Budget vs. Forecast visualization provides a view of budgeted GL numbers and
their comparison with actual numbers and forecasted numbers for future periods.

By visually depicting these differences, it enables banks to analyze the accuracy of their
budgeting and pinpoint areas of over- or under-budget spending, assess alignment with
financial goals, and refine future budgets to enhance accuracy and effectiveness in financial
planning. Forecasted numbers can give a view into future projections vs current numbers.

ORACLE 8-47



Chapter 8
Data Browser

Figure 8-84 Actual vs Budget vs Forecast
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8.1.3.9 Credit Line Summary

This pre-built report is based on Credit Line subject area. It gives an overview.

«  Credit Utilization by Parties: This bar graph illustrates total credit line against the utilized
amount, and helps bank quickly assess the overall credit utilization rate. This helps in
identifying trends over time, such as increases in credit usage which might indicate
economic stress among borrowers or a growing confidence and spending capability. The
visualization helps user analyze credit utilization numbers for each party and currency as
of date and analysis can be done at branch level.

— Objective — To highlight the total credit line and utilized amount for various parties
across different currencies as of given date for selected branch/branches.

Figure 8-85 Credit Utilization by Parties

k£ Credit Utilization by Parties

= Legal Entity Name = Calendar Date Branch Name
All

Credit Utilization

B Credit Line Utilized Amount Total Credit Line Amount
PARTY_1 PARTY_10 PARTY_2 PARTY_3 PARTY._4 PARTY_S PARTY_6
5.26M 23.37M 7.57M "
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« Utilization Across Product Types: The visualization illustrates the total credit line
commitment amounts and the utilized amounts across different products denoted in
multiple currencies. This helps to analyze which products are most and least utilized,
banks can identify successful features or gaps in their offerings. This information can drive
the development of new products or adjustments to existing ones to better meet customer
needs.

— Objective — To highlight the total credit line amount and utilized amount by different
product types for selected branch/branches.
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Credit Line Distribution: The Visualization provides insight into the predominant credit

allows a bank to tailor its products to better match local

demand. This helps management to assess the commitment track to aid in performance
review and Risk management.

Objective — To view num
within the legal entity.

ber of credit lines by credit line purpose for each branch

Figure 8-87 Credit Line Distribution
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Credit Line Status: The dashboard illustrates the segregation of credit lines into various

credit status categories such as fully performing, delinquent and impaired. This helps
Banks to quickly identify areas of concern, particularly the proportion of non performing or
delinquent accounts. This allows for early intervention strategies to be deployed, such as
reaching out to customers who are falling behind on payments to offer restructuring or
support services that might prevent further delinquencies.

Objective — To view num

Activity - Results Data Browsing

ber of credit lines by credit line status like fully performing,

delinquent, impaired for each branch within the legal entity.
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Figure 8-88 Credit Line Status
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Participation and Volume Analysis: The visualizations show the participation flag for
credit lines alongside the sum of total credit line amounts tagged with that flag which helps
banks in analyzing how participation in specific credit programs impacts their overall credit
portfolio. Participation flag indicates if the credit line facility is a part of the syndication.

Objective — To highlight the total credit line amounts and Participation counts by Legal
entity and Calendar date.

8-50



Chapter 8
Data Browser

Figure 8-89 Participation and Volume Analysis
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8.1.3.10 Drill through option

Drill-down functionality enables user to view data at the lowest granularity. The lowest
granularity level at which the user is able to drill is specific to a given subject area (SA) on
which visualization is based and attributes present in that subject area. For example: In
Account subject area, the lowest level granularity would be accounts (account key in fact
entities and account identifier in stage entities). Similarly for transaction subject area, lowest
level granularity available for viewing via drill through will be transaction identifier.

The solution currently supports drill-through up to data in results entities, and not for stage
entities.

Functionality is available for all pre-built reports for attributes that are contributing towards data
for that pre-built report. Drill through can be done for all types of visualizations including but not
limited to tabular, pivots, graphical, pie charts, time series, and so on.

Data viewed post drill-through pre-applies all the filters and shows user the specific granular
data that user was viewing before drill through.

ORACLE"

8-51



Chapter 8
Data Browser

1. Go to chart where user needs to see specific data -> Right click -> Drill to attribute/
Hierarchy -> Select specific hierarchy for which user wants to view data.

Figure 8-90 Drill through option
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Figure 8-91 Dirill through option Data Elements
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8.2 Data Quality Visualizations

ORACLE"

The Data Quality Visualization provides critical insights into data quality issues detected after
executing Data Quality (DQ) rules within the DFCS solution. The DFCS solution runs
predefined DQ rules and publishes the results in interactive dashboards. The dashboards
present a comprehensive view of error records associated with specific entities, helping users
identify data inconsistencies.

To access DQ dashboards, follow the below path:

Data Quality Dashboard > Catalog > Shared folders > Data Quality Visualizations > Data
Quality.

This section provides information on the Data Quality results for Data Visualization reports.

To access the Data Quality for Data Visualization Reports in DFCS, complete the following
steps:

* Onthe Home page, click Catalog, and under the Shared Folders tab, select Data Quality
Visualization and then select data Quality Reports to view the details of the Data Quality
results.

* Data Quality Results for Data Visualization Reports page
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You can navigate among the following canvases in the Data Visualization report:
— Data Quality Registry

— Data Quality Summary

— Data Quality Executions

— Data Quality Results

Figure 8-92 Data Visualization report
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Figure 8-94 Data Quality Execution

e 5.00K 26.70%

MO A

163M 378K 23.24%

8.3 Use Case Analysis

The Use Case Analysis is a pre-built, out-of-the-box report designed to support customers
who choose to onboard multiple applications in a sequence. In this context, each application
represents a distinct use case. The report provides customers with a clear view of how many
additional data elements would be required to onboard subsequent applications after starting
with one. It also highlights the total number of data attributes used by each application, the
number of common attributes shared across applications, and the additional attributes unique
to each application. This helps customers plan and manage their data onboarding process
more efficiently.

To access DQ dashboards:

1. Navigate to the Catalog menu, and click on the Shared Folders tab.
2. Navigate to Data Foundation Reports.

3. Locate the Use Case Analysis folder in the list and click Use Case Analysis.
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Inside the folder, open the Use Case Analysis report.

The Use Case Analysis > Visualize window appeatrs.

Figure 8-96 Visualize Window
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Accounting Foundation Cloud Service
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Liquidity Risk Management

Profitability Management for Insurance

Use Case Analysis Window

Here’s a breakdown of the main items available in the Use Case Analysis window. On the
Visualize window, the following canvas are available in the Use Case Analysis report:

Summary

ORACLE

Summary — Overview of all use cases and attributes.
Use Case Details — In-depth details for each use case.
Use Case Comparison — Side-by-side comparison of use cases.

Attribute Details — Breakdown of attributes within each use case.

The Summary section provides an overview of how to use the tool effectively, including how to
assess additional elements required for integration with other financial products.
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Figure 8-97 Summary Window
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» Determine the impact of additional financial products.
« ldentify missing elements needed for full integration.
* Understand table relationships between different applications.

« Percentage-Wise Requirement Analysisldentifies percentage gaps (e.g., a customer needs
to bring in the remaining 25%).

« Helps determine which additional datasets, calculations, or reports are necessary for
complete functionality.

« Balance Sheet & Customer Data IntegrationEvaluates which balance sheet elements must
be incorporated.

* Assesses customer data integration requirements for analytics and compliance.

Use Case Details

The Use Case Details section provides an overview on how to analyze entity usage across
various use cases in financial or business management.
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Figure 8-98 Use Case Details
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e Check the percentage indicator to see what portion of the required data is already

available.

e Review the missing components and determine what additional elements must be

integrated.

Use Case Comparison

This section provides an overview on how to compare attributes across different financial/
business use cases. It displays percentage coverage of attributes between the reference use

case and comparative use case.

Figure 8-99 Use Case Comparison
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Reference Use Case: Acts as a benchmark for evaluating other use cases.

Comparative Use Case: The use case that is directly compared to the Reference Use
Case.

Number of Common Attributes: The count of shared Entity.Attributes between the
Reference and Comparative Use Cases.

Number of Additional Attributes Required: The count of extra Entity.Attributes needed
for the Comparative Use Case that are not included in the Reference Use Case.

% of Comparative Use Case Attributes Available in Reference: The percentage of
attributes from the Comparative Use Case that are present in the Reference Use Case.

Example

The pop-up tooltip (hovered over any entity) provides:

Number of attributes in the Reference Use Case (1,210).
Number of attributes in the Comparative Use Case (1,881).
Number of Common Attributes (194).

Number of Additional Attributes Required (1,687).

Percentage of Comparative Use Case Attributes available in the Reference Use Case
(10%).

Insights:

— High percentages (green areas) indicate a strong overlap of attributes between
reference and comparative use cases.

— Low percentages (red areas) suggest gaps or differences between the datasets.

— Some cells show 100% coverage (e.g., "Funds Transfer Pricing"), meaning the
attributes completely match between the two use cases.

Attribute Details

Attributes Details report within a Use Case Analysis dashboard is structured as a data table
showing attributes related to financial or business processes.

ORACLE
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Right To Forget
Figure 8-100 Attribute Details
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The interface consists of two main sections:

Data Table (Attributes Details) — Displays key dataset details:

Use Case — Business process or scenario

Grain — Level of data detall

Entity — Business data objects

Attribute — Specific data fields (e.g., "Account or Contract Number")

Usage Type — Classification of attributes (e.g., "Mandatory" means required)

8.4 Right To Forget

The Right to be Forgotten (RTF) feature ensures that businesses protect sensitive Personally
Identifiable Information (PII) related to party data. This functionality is available in Data
Foundation Cloud Service (DFCS) and involves randomizing party data when it is no longer
needed in the system.

ORACLE

RTF Process Overview

The RTF process is executed as a PMF job.
It is user-driven, requiring customers to input Party Identifiers that need to be forgotten.

Users must provide Party Identifiers through a PMF input, with multiple IDs entered as
comma-separated values.

Before executing the RTF process, users must invoke the SCD process (DIM Incremental
Process) to update the Party Dimension.

Only Party IDs present in the Party Dimension will be considered for randomization.

RTF Execution Details

For each RTF request, the service checks if the user has sensitive Pll-related party data
in any entity.
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If such data exists, the system fetches the list of affected entities and randomizes the PII-
related data.

The RTF Metadata Registration Table is preconfigured with Party Identifier (Business
Term - BTO3899) for executing the RTF functionality.

RTF Data Visualization Reports

The following RTF-related information can be viewed in Data Visualization (DV) reports:

1
2
3.
4

10.

11.

Navigate to the Catalog menu, and open the Catalog application.
Click on the Shared Folders tab.
Navigate to Data Foundation Reports.

Locate the Right To Forget folder in the list and click Sensitive Data Anonymization. For
more information, see Pre-Built Reports.

Dashboard Sections:

* Customer Request and Status — Displays request detalils.

* Audit Log — Tracks affected records for accountability.

RTF Customer Request Table — Stores details of each RTF request, including:
* Request Identifier — Unigue request number.

* Requested Date — Date of submission.

* Requested By — Username of requester.

* Party Identifier — Entity involved.

* Execution Status — Indicates success or failure.

Reviewing the Audit Log:

« Party Identifier — Matches request ID.

« Entity Name — Type of entity affected.

* Records Affected — Number of modified records.

Filtering and Searching Requests:

* Use filters (e.g., Date, Requested By, Status) to narrow results.
* Select a request to view details in the Audit Log.

Verifying Execution Status & Impact:

» If successful, check affected records.

« If failed, troubleshoot using system logs.

RTF Execution Status — Once the RTF Engine PMF process completes, the system logs
the execution status:

« Ifthe Party ID is not found, the system updates the status as Not Available and exits.
RTF Audit Log — Maintains execution records at the Entity Level, including:
* Date of execution

«  Number of records affected

Post-Execution Considerations

Once an RTF request is successfully processed, the party data is randomized and
secured.
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* To maintain data integrity, users must ensure that the forgotten Party IDs do not re-enter
the system during data loads from multiple sources into DFCS.

To navigate to the DFCS Right to Forget, follow the below steps:
1. Navigate to the Data Foundation for Banking home page.

2. Click on Data Pipelines under the Data Integration section. The Process Modeller
window will appear.

3. Inthe Process Modeller search box, enter Right to Forget. Alternatively, scroll down to
locate the process manually.

Ensure that the Pipeline Filters are listed.
Click Search to proceed or Cancel to modify the details.

The Right to Forget process name will appear in the results.

N o g »

On the Right To Forget window, the following options are available:

e Launch Process in New Window

«  Version (Displays the process version)

* Instances (Shows active instances)

» Application Type (Displays application details)

*  Modification Details (View last modified details)

e Delete (Remove the process)

*  View (Check process details)

e Copy (Duplicate the process)

*  Process Flow Monitor (Track execution flow)

e Execute Run (Run the process)

*  Filter (Refine search results)

8. Inthe Right to Forget window, locate and click on the Execute Run option.

9. Choose one of the following execution types:
*  Without Parameters — Runs the process without requiring additional inputs.
*  With Parameter — Requires user-specified inputs before execution.

10. If executing With Parameter, enter the Object ID in the designated input field.

11. Click on the Execute button to start the process.

12. Track the execution progress in the Process Flow Monitor.

13. Check logs for status updates and any potential errors.

14. Click on the ellipsis (0) button next to the running process.

15. Choose an Action:

* Resume — Continue a paused or failed execution.

* Re-Run - Restart the process execution from the beginning.

* Abort — Stop the execution immediately if necessary.

16. Confirm Action (if prompted): Depending on the action chosen, you may need to confirm
before proceeding.
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8.5 Balance Reconciliation Visualizations

ORACLE

The GL Reconciliation process ensures that balances from a bank's operational systems
(typically standard product processor entities) are reconciled with the General Ledger (GL)
balances.

GL Reconciliation Visualizations: The dashboards provide insights into reconciliation
differences detected after executing the reconciliation process. Key components include:

< Reconciliation Differences — Highlights discrepancies between operational balances and
GL balances.

e Threshold Breach Summary — Identifies instances where reconciliation variances exceed
predefined thresholds.

« Adjustments Summary — Displays adjustments made to correct discrepancies.
Steps to Access GL Reconciliation in DFCS:

1. Onthe Home page, navigate to the LHS (Left-Hand Side) menu and click Catalog.
2. Under the Shared Folders tab, select Reconciliation Framework.

3. Click on Dashboards to view GL reconciliation results.

Accessing GL Reconciliation Dashboards

To view the GL Reconciliation Dashboards, follow these steps:

1. Navigate to Shared Folders.

2. Select Reconciliation Framework.

3. Click on Dashboards to access the reconciliation results.

GL Reconciliation Results — Data Visualization Reports:

Within the Data Visualization Reports, users can navigate through the following canvases:
*  Home - Overview of reconciliation results.

* Threshold Breach — Displays instances where reconciliation variances exceed predefined
limits.

« Map Filter Report — Provides a detailed view of reconciliation mappings and applied
filters.
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Figure 8-101 Access GL Reconciliation in DFCS
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For further details on using dashboards, refer to the Oracle® Financial Services Data
Foundation Cloud Service for Banking Data Controls User Guide.

8.6 Custom Attributes

Catalog extension — it is not update the OBIEE catalog automatically.

User should add equal number of attributes for the respective entities being extended and map
the same individually as per the changes in the catalog.

DFCS supports Custom Attributes in out of the box dimensions for Accounts Subject Area.
Users can use the Reporting Configuration window to map the Custom Attributes in OOB
dimensions.

8.6.1 Custom Attributes Creation

ORACLE

To define a custom attribute in OOB table, complete the following steps:

On the DFCS Home page, click the My Profile icon and select Administration.
Click Report Configuration.

Select the OOB table and click on the Edit icon.

Select the attribute based on data type needed like date, numeric or string.
Click on the Edit icon in the Attribute mapping window.

Select the Attribute name from the dropdown list and click Save.

N o g & w N PR

To delete a custom attribute, select the attribute and click on Delete icon.

# Note:

User cannot Edit or Delete the OOTB dimension, it will display NA flag in the
Dimension Mapping window. The available and mapped flag for Custom
Attributes are displayed in the Attribute Mapping window to show the availability
of attributes.
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g are the number of custom attributes by data type that can be defined for existing

OOB entities supported in the current release for Accounts subject area:

PRESENTATION NUMERIC STRING DATE
ENTITY NAME

Organization Unit 55 110 5
General Ledger Account 55 110 5
Product 20 20 5
Legal Entity 20 20 5
Branch 20 20 5
Business Unit 20 20 5
Account 10 41 8
Location 20 20 5
Account Summary 30 10 10

8.6.2 Custom Attributes Visualization

In order

to view the extended custom attributes in a staging table and view their logical names,

user can create a Dataset and generate reports in the Data Visualization using OAS interface
using Create Dataset Option available on top right.

To create a dataset and view the custom attributes in staging tables in the Data Visualization

canvas i

n DFCS, complete the following steps:

1. On the Home page, click the Create icon and then click Dataset.

2. The
a.
The
a.

b.

d.
e.
f.

You

ORACLE

Dataset page is displayed.

Click Create and select Dataset from the available list.

Create Dataset window is displayed with the list of available connections.
Double click on the DS Connection and the New Dataset page is displayed.

From the LHS menu, double click on the Manual Query, the Manual Query button is
displayed.

Double click on the Manual Query button, and enter the SQL query under the
Statement window.

Click Get Preview Data to preview the data of the entered query.
Click Save and the Save Dataset As window is displayed.
Enter the Name and Description of the dataset and click OK.

can view the list of extended columns in the staging table.
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Figure 8-102 Custom Attributes Visualization
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Users can resolve any data issue identified in the Cloud framework by creating Issues and
appropriate Actions on the Inbox page. Data Issues such as Data Quality failures, Variance
breaches, or even known issues can be fixed using the Adjustment Framework option in
Action. The adjustment entries posted are audit trailed and data traceability enabled.

For more information, refer to the Oracle® Data Foundation Cloud Service Data Platform
guide.
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Issues and Actions

You can resolve any data issue identified in the Cloud framework by creating Issues and
appropriate Actions on the Inbox page. Data Issues such as Data Quality failures, Variance
breaches, or even known issues can be fixed using the Adjustment Framework option in
Action. The adjustment entries posted are audit trailed and data traceability enabled.

For more information, refer to the Oracle® Data Foundation Cloud Service Data Platform
guide.
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Key Terms and FAQs
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Adjustment Entry

An entry passed in the Product Processor (PP) to reconcile it with the associated GL for
the amount equivalent to the difference and an entry in the Contra GL Account with the
opposite sign for the same amount.

Adjustment Entry Floor

If the difference between Source and Target is less than the Adjustment Entry Floor
specified in the definition, the calculated difference is not eligible for adjustment, and the
entry will not be logged in the Adjustment Entry Table.

Attributed Dimension
A dimension whose members can have other properties or qualifiers known as Dimension
Attributes.

Dataset

A dimension used for segregating data into different sets according to its use or its source.
For example, to separate actuals data, budget data, and encumbrances data. Other uses
include separating test data from production data and creating separate data sets for
What-if Analysis.

Dimension

A structure that can be used to categorize business data. A dimension contains members;
it can be hierarchical (you can organize the members into one or more hierarchies), or
non- hierarchical.

Dimension Attributes

A property or qualifier that further describes a dimension member. An attribute can be a
date, a number, or a character string. For example, the Geography dimension can have an
attribute - Population, that designates how many people live in that area. Each member of
the Geography dimension, therefore, has an associated Population.

Hierarchy
A structure of dimension members organized by parent-child relationships.

Global Threshold
Global Threshold is applied at an execution level where all the reconciliation differences for
execution are added and checked across the absolute sum of source balance.

Inherit to Child

This feature is used to find child legal entities under the hierarchy node of a Legal Entity
that is selected at the definition level. If used while defining the GL Reconciliation rule, all
child nodes will participate in the reconciliation process.

Reconciliation

Reconciliation is the process of comparing information from one data source to another. An
Account Reconciliation is for a specific period. Reconciliations consist of account balances
(obtained from the Source System for the period) and account properties.

Reconciliation Difference
Reconciliation difference is the difference in the balance between the Source and the
Target.

Threshold
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A tolerance level you must set in terms of either the maximum difference allowed in any
single Product Processor and its corresponding GL or the maximum number of Product
Processors having differences in the GL Reconciliation.

Positive Threshold

These values are used to identify the breach types categorized as Not Breached (NB). The
Breach Type is identified at run time during the reconciliation process, and Audit Trail
entries are posted with this information.

Negative Threshold

These values are used to identify the breach types categorized as: Negative Percentage
Threshold (NPT), Positive Percentage Threshold (PPT), Negative Absolute Threshold
(NAT), Positive Absolute Threshold (PAT), and Not Breached (NB). The Breach Type is
identified at runtime during the reconciliation process, and Audit Trail entries are posted
with this information.

Threshold Breached Type
The different types of threshold breaches are listed here.

— PAT - Positive Absolute Threshold

— NAT - Negative Absolute Threshold

— PPT - Positive Percentage Threshold
— NPT - Negative Percentage Threshold
— G- Global

— NB - Notbreached

General Ledger to Product Processor

General Ledger to Product Processor Reconciliation identifies the difference between GL
system and Product Processor data. It nullifies the difference by posting the adjustment
entries up to the amount of difference.

General Ledger to Product Management Ledger

In General Ledger to Management Ledger (GL to ML) reconciliation, the difference
between two sources of the Ledger for the same Legal Entity and the Consolidation Type
is identified. This difference is identified at the granularity of the GL code for the selected
hierarchy, the mandatory dimensions, and the selected optional dimensions. Adjustments
are not passed in General Ledger to Management Ledger reconciliation.

Consolidation Type
Two consolidation types are supported:

— Solo
When a legal entity is selected with consolidation type as Solo, all the exposures of
that particular legal entity are selected for processing. Manual reconciliation definition
can process solo legal entity data.

— Consolidated
When a parent legal entity is selected as Consolidated, all the exposures of that legal
entity and exposure of each level (or levels) of descendant child legal entities (without
intra-group exposures) are selected for processing. In intra-group exposures, the
counterparty is a child descendant of any level. For an intra-group scenario (where the
GL Structure has specific intra-group GL Code in addition to regular GL Codes), intra
GL Codes are considered only from the GL side for processing. Non-Intra is a scenario
where no GL Codes are present for reconciliation definition.

— Inherit to Child
This feature is used to find child legal entities under the hierarchy node of a Legal
Entity that is selected at the definition level. If used when defining the GL
Reconciliation rule, all child nodes will participate in the Reconciliation Process.
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Manual Reconciliation Definition

In manual reconciliation definition, user input is sought on the GL side and PP side to
determine the course of reconciliation. This is applicable to both GL level and map
level reconciliation. In GL level reconciliation, unique GL codes are identified from the
GL code mapping. At the map level, GL codes do not form a part of the reconciliation
definition. A manual reconciliation definition can be used for a solo or consolidated
legal entity. The reconciliation definition for a consolidated GL, having an intra-group
GL structure, is computed from GL Data and not from PP Data. Therefore, any
account present in the PP but unavailable in GL is not captured in the reconciliation
definition.

GL Level Reconciliation

In GL level reconciliation, the difference between GL system and Product Processors
Systems at each reconciliation dimension node level within a GL Code is identified.
For manual reconciliation definition, uniqgue GL codes are identified from the GL side. If
it is at the solo level, exposures originating in the legal entity are selected. If it is at the
consolidated level, exposures originating in the selected legal entity and its Child
Entities (with or without intra- group exposures depending on GL Structure) are
selected.

The adjustment entry allocation depends on the reconciliation type selected. In GL
level reconciliation, after a definition is executed, the differences that emerge as a part
of the reconciliation definition (GL—PP level reconciliation) are reported in the
Adjustment Entry Table. This table shows all the entries of an executed map that
requires adjustment. The difference in amount can either be posted to Product
Processors or an external table. For more information on the external table, see the
Data Requirement section.

Map Level Reconciliation

In map level reconciliation, the difference between GL Data and PP Data at each
reconciliation dimension node level across all PPs is identified. Unlike GL level
reconciliation, map level reconciliation is computed at an aggregate level of the
reconciliation definition; by ignoring the GL code and by considering reconciliation
dimensions. Map level reconciliation is applied at the legal entity level - either solo or
consolidated. If it is at the solo level, then exposures originating in a particular legal
entity are selected. If it is at the consolidated level, then exposures originating in the
selected legal entity and its child entities (excluding intra-group exposure depending
on GL structure) are selected.

The adjustment entry allocation depends on the reconciliation type selected. In map
level reconciliation, after a definition has been executed the differences that emerge as
a part of the reconciliation (General Ledger—Product Processor Level Reconciliation)
are reported in the Adjustment Entry Table. This table shows all the entries of an
executed map that requires adjustment. The difference in amount can either be posted
to Product Processors or an external table. The adjustment allocation can be either
automatic or manual.

11.1 Frequently Asked Questions

ORACLE

You can refer to the Frequently Asked Questions, which is developed with the interest to help
you resolve some of the DFCS Installation and Configuration Issues. This intends to share the
knowledge of problem resolution to a few of the Known Issues. This is not an official support
document and just attempts to share the knowledge of problem resolution to a few of the
Known Issues.

What happens when users try to log in during a maintenance period?
When the instance is under maintenance, a “Maintenance Page” is displayed.
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2. What happens for the users that are logged in?

If users are already logged in, all further actions are blocked. On refresh, users are
directed to the Maintenance Page.

3. Can APIs be invoked during maintenance period? No. The API requests are blocked.
No. The API requests are blocked.

4. What happens to ongoing batches?

Batches will continue, however, it is recommended to ensure all processes are completed
before maintenance begins.
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